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Preface

Welcome to the GV-Web Report User’'s Manual.

This Manual is designed for the following software version:

Product Version

GV-Web Report V3.1.0.0

Note: GV-Smart Box is no longer supported.
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Naming and Definition

GV-3D People GV-3D People Counters refer to GV-3D People Counter and GV-
Counter 3D People Counter V2. The GV-3D People Counters count and
analyze the number of people passing by in the designated
detection area. A built-in Web interface, the GV-Web Report Lite
provides you with an easy setup and accurate people counting
results.

GV-DVR / NVR GeoVision analog and digital video recording software. In most
documents, the GV-DVR / NVR also refers to Multicam System,
GV-NVR System and GV-Hybrid DVR System at the same time.

GV-Smart Box The GV-Smart Box is a standalone device featuring People
Counting, Face Counting and Object Size Counting functions.
Through the Web browser, the GV-Smart Box delivers live view, face
snapshots and counting results.

GV-VMS GeoVision Video Management System for IP cameras.

Note for Upgrading GV-Web Report

To upgrade GV-Web Report, run the Installer (setup. exe) included in the latest software
downloads from our website. Select Reinstall/Upgrade to start.

InstallShield Wizard >
Welcome ‘“
Rernstal / Upgrade, or remave the program. I ~

W eloome to the GYA4/=bReport Setup Maintznance program. This program lets pou modfy the
cunent nstallabon Click one of the options b=low

(# Renzal / Upgade
ﬁ Reinztall all program comporerts nstaled by the previous setup,

" Remove
r@ Remove allinstaled comporents.

< Back e > Cancal
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n Introduction

Chapter 1 Introduction

GV-Web Report is a centralized analytics platform that integrates data from GV-3D People
Counter, GV-NVR, and GV-VMS for people counting, face counting, and POS transactions.
Designed for scalability, it can receive and process data from up to 1000 units of GV systems
and devices, making it ideal for large-scale video surveillance deployments.

The Web interface provides flexible reporting capabilities, allowing users to generate real-
time, hourly, daily, monthly, and yearly reports and graphs for operational insights.

GV-NVR / VMS (dbSync 2) GV-3D People Counter

Up to 10,00 units —

Send people / face
counting / POS data {

GV-Web Report Servi)
. Access counting data \ -

User (Web browser) User (Web browser)

N 7

Figure 1-1
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Features

e Up to 1000 units of GV-3D People Counter and GV-NVR / VMS supported
e People counting results from GV-3D People Counter and GV-NVR / VMS
e Face counting results from GV-NVR / VMS

e POS data from GV-NVR / VMS

e Heat Map images from GV-VMS

e Real-time, daily, monthly, yearly counting reports and graphs

e E-mail notifications and I/O trigger when the remaining occupancy reaches the specified
maximum

e Counting result query from iOS and Android mobile devices
¢ Grouping function for combining desired cameras for data analysis
e Automated data export scheduling

e 4 languages supported: English, Russian, Simplified Chinese, and Traditional Chinese

Note: GV-VMS V20 does not support the transmission of the following data types to GV-
Web Report: Face counting, POS data, and Heat Map.




1.1 Minimum System Requirements

n Introduction

The following are minimum system requirements for the server to run GV-Web Report.

GV-NVR/VMS
GV-NVR V8.3.2 or later
GV-VMS V16.10 or later, V20.0 or later
Application .Net Framework 3.5 or later
dbSync2
Note:

1. .Net Framework and dbSync2 can be downloaded from Microsoft and GeoVision

websites.

2.  GV-VMS V20 does not support the transmission of the following data types to GV-
Web Report: Face counting, POS data, and Heat Map.

3. GV-VMS V20 does not support dbSync2.

GV-Web Report

mode.

32-bit | Windows 10/8 /7 / Server 2008
OS Supported

64-bit | Windows 11/10/8/ 7 / Server 2008
Application .Net Framework 3.5 or later
Browser IE, Chrome, Edge, Firefox
Hardware External or Internal GV-USB Dongle
Note:

1. .Net Framework can be downloaded from Microsoft website.

2. ltis recommended to use the internal GV-USB Dongle to have the Hardware
Watchdog function which restarts the PC when Windows crashes or freezes.

3. Live view and playback functions are supported only via IE or Microsoft Edge in IE

Software License

Free License

N/A

Maximum License

1000 clients

Increment for
Each License

200, 500 or 1000 clients

Optional Combinations

N/A

Dongle Type

Internal or external

Note: The Maximum License is a paid service.
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Compatible Versions of GeoVision Applications
GV-Web Report is compatible with the following GV-3D People Counter models.

Device GV-3D People GV-3D People GV-3D People
Counter V1 Counter V2 Counter V3
Software
GV-Web Report
V2.2.3.0 V1.01
N/A

GV-Web Report
V2.24.0-V2.25.0
N/A

GV-Web Report
V2.2.6.0
V1.02 or later

GV-Web Report V3.0

V1.00 or later
or later

GV-Web Report

V3.1.0 or later V1.00 or later




E Installation

Chapter 2 Installation

GV-Web Report can be installed on a separate computer or on the same computer as GV-
DVR/NVR/VMS. However, for optimal performance and system stability, installation on a
dedicated computer is recommended.

Before installing the GV-Web Report, ensure the following components are in place:
o USB dongle is inserted and its driver is installed
o .Net Framework is installed

Follow the steps below to complete the installation:
1. Download GV-Web Report and GV-Series Card Driver / GV-USB Device Driver from

the GeoVision website.

é‘ Version History GV-Web Report V3.0.1A 101KB ﬁfa 2022-06-20
é‘ GY-Web Report V3014 135MB RA 2022-06-20
El & / 4 _N1-N5
e Dbsync2 V3.0.0.0 6.2MB — 2018-01-05
¥ Content Designer (for GV-3D ] 3
i V1.0.7.0 11.1MB — 2016-06-13
Lz | People Counter)
i GV-Series Card Driver / GV-USB VE57.0 5 9MB 3 2016-12-07
ERN Device Driver R = -

Figure 2-1
2. Unzip the GV-Series Card Driver / GV-USB Device Driver file, and run GvUSB-x64.exe
to install the USB dongle driver.
3. Unzip the GV-Web Report file and run GV-WebReport.exe.
4. For the first-time user, you must create a password (lower case only). The default

account is admin.


https://www.microsoft.com/en-us/download/details.aspx?id=30653
https://www.geovision.com.tw/download/product/GV-Web%20Report
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Chapter 3 Getting Started

The GV-Web Report server is designed to analyze counting data from GV-3D People
Counters, GV-DVR/NVR/VMS systems, and GV-Smart Boxes. It provides web-based
access to real-time and historical analysis data, allowing users to view reports remotely
through any standard Web browser.

3.1 Starting GV-Web Report

To start the GV-Web Report service, follow the steps below:

1.  Run the GV-Web Report (from Windows Start menu or from your desktop). For the
first-time user, you will be prompted to type a password. The default ID (account) is

admin.

2. Onthe GV-Web Report window, click Service from the menu bar and select Start all
services to start receiving data from connected GV-3D People Counters,
GV-DVR/NVR/VMS, and GV-Smart Boxes.

3.2 Connecting to GV-3D People Counter V3

For detailed instructions on how to connect GV-3D People Counter V3 to GV-Web Report,
see 7. Connecting to GV-Web Report in GV-3D People Counter V3 Quick Start Guide.



https://dlcdn.geovision.com.tw/Manual/3D-People-Counter/V3/GV-3D_People_CounterV3_QuickGuide.pdf

Getting Started

3.3 Connecting to GV-3D People Counter V1 /V2

To send people counts from a GV-3D People Counter V1 / V2 to the GV-Web Report server,
you need to configure the settings in the Web interface of the GV-3D People Counter to
allow connection to the GV-Web Report. For details, see Chapter 3 The Web Interface in
GV-3D People Counter User’'s Manual or GV-3D People Counter V2 User’'s Manual
depending on the device you purchased.

1. In the Web interface of the GV-3D People Counter, click the Setup tab on the top. The
following steps take GV-3D People Counter V2’s setup page as example.

2. Under the Detection Setting page, select Report to Server.

Device Height: cm Range: 180~400cm
Minimum People Height: cm Range: (80 ~ 240)cm
¥l Device and Object Distance < 60c

People between 80~240 cm can be detected
Detected Sensitivity:
Detect Area: |Counting Position v

M wrong Direction Alarm

@ In (Exit Only) O Out (Enter Only)

Detail

In/Out Direction Change: Change (Green: In, Red: Out)

Report to Other Server
Download recorded file O Time Sync
Host name or IP Address: |192.1 1.1 | Port: | 30003‘
| USER DDNS SMIP EXPORT SCH IP SD PW TIME MEM GPS IO Name: |1 Password: e
Gl [JReport to Server 2
Machine Name: [GV-3D People Counter V2 | Time Sync
Login Name: |admin | port: [ 30003 Default 20003 Host name or IP Address: 0.0.0.0 Port: | 30003

Password: |[eseee Name: Password:
Confirm Pw:

[IRreport to Server 3

Time Sync

Host name or IP Address: |0.0.0.0 Port: | 30003
Name: Password:
Reset | | save
Figure 3-1

3. Type the IP address of the GV-Web Report, and modify the default Port 30003 if
necessary.

4. Type the Name and the Password to access the GV-Web Report.

5. If you click Time Sync under one of the servers, the time of the current GV-3D People
Counter will be synchronized with the selected server. To cancel time synchronization,
double-click the selected radio button.


https://dlcdn.geovision.com.tw/Manual/3D-People-Counter/GV-3D_People_CounterV2_UserManual.pdf
https://dlcdn.geovision.com.tw/Manual/3D-People-Counter/GV-3D_People_CounterV2_UserManual.pdf
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3.4 Connecting to GV-DVR/NVR/VMS

To transmit people counting and POS data from GV-DVR/NVR/VMS to GV-Report, you may
need to install the dbSync2 program on the same computer where GV-DVR/NVR/VMS is

installed.

dySync 2 Compatibility with GV-Web Report

GV-VMS | Requires Live View on | Playback on Connection Note
Version | dySync 2 Web Report Web Report
VA7 Yes Yes Yes Requjres ijSync 2 for full
functionality.
dySync 2 required when
. . people and face counting is
V18 Not a Must Ieg (r?glg)wﬂh :j(e; (r(])éﬂ%/)WIth performed by GV-VMS itself,
yoy yoy rather than processed on Al-
capable cameras.
V20 No No No dySync 2 is not supported.
Note:

1. dySync2 is required only for GV-NVR (V8.3.2 or later) and GV-VMS (V16 to V18) when
people and face counting is performed by the GV-NVR/VMS system itself, rather than
processed on Al-capable cameras.

2. dbSync2 is not supported by GV-VMS V20.

3. To transmit the counting data from Al cameras, connected to GV-VMS, to GV-Web
Report, see 3.4.4 Sending Al Camera Counting Data via GV-VMS.

3.4.1 Configuring the dbSync2 Program on GV-DVR/NVR/VMS

The dbSync2 program, installed on the GV-DVR/NVR/VMS computer, performs two key

functions:

e Transmits people counting and POS data to the GV-Web Report server
e Enables remote access to GV-DVR/NVR/VMS for live video streaming and playback

viewing
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To configure the dbSync2 program, follow the steps:

1. Download and Install DySync2 from the GeoVision website.

2. Run dbSync2. This dialog box appears.

adl

Synchronization time:
[ Daily Sync. Time
Time 12:00:00 S
Update Interval Sync

Time Minute(s)

[] Run at Startup

Setting Batch 0K Exit

Figure 3-2

m Daily Sync. Time: Specify a time to send the data to the GV-Web Report server
automatically.

m  Update Interval: Specify a time interval in minute to send the counts to the GV-Web
Report server automatically.

m  Run at Startup: Enable this option to run dbSync2 at system startup.
m  Sync: Click this button to send the data to the GV-Web Report server immediately.

m Batch: Click this button, and select the desired data files to be sent to the GV-Web
Report server. The files of people count are named with prefix "sys", e.g.
sys20071127. The default path for data files is: \GV folder\database.

m  Setting: Click this button to configure connections to the GV-Web Report server.


https://www.geovision.com.tw/download/product/GV-Web%20Report
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3. Click the Setting button. This dialog box appears.

’3 Setting 4

Sync Configuration

Database Path:  [CAGV-VMS\Database Browse

GV-Web Report Configuration

IPAddress :  |1127.0.0.1 | | Test

Port: 130000 |

User Mame : |admin |

DVR Configuration(For remote access)
IP Address:

Password :

Command Port:  [4550
Data Port: 5550
Audio Port: 6550

Viewlog Port: h552

User Mame :

(o | =]
a M
3 =
El =

=]
—h

Password :

pdate

Figure 3-3
[Sync Configuration] Displays the database path. The default path for database is:
\GV folder\database.

[GV-Web Report Configuration] Type the connection information of the GV-Web
Report server, including its IP address or domain name, login username and password.
The default port value is 30000. Click Test to connect to the GV-Web Report server.
Upon successful connection, a confirmation message will appear on both the GV-
DVR/NVR/VMS and the GV-Web Report.

Note: Ensure that the GV-Web Report service has been started (see 3.7 Starting the GV-
Web Report). Otherwise, the connection attempt will fail.

10
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[DVR Configuration for Remote Access] The configuration allows remote access to
the live video and the recordings of GV-DVR/NVR/VMS. Before the configuration, enable
WebCam Server on GV-DVR/NVR/VMS first so that the dbSync2 program can
automatically acquire the necessary port values (Common Port, Data Port, Audio Port
and Viewing Port) from the GV-DVR/NVR/VMS. Type the IP address or domain name,
login username and password of the GV-DVR/NVR/VMS. Then click Update to send the
configuration values to the GV-Web Report server.

4. Click OK. The dbSync2 program is minimized to the notification area.

‘r‘ . |t B3 PM

When people counting and POS data are logged to the GV-DVR/NVR/VMS, the dbSync2
program transmits the data to the GV-Web Report server at the specified time or interval
each day. In addition to querying counting and POS data, users can also view live video and
playback recordings remotely via a Web browser.

11
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3.4.2 Sending People Counting Results

Since the dbSync2 program only transmits logged count data to the GV-Web Report server,
it is essential to configure one of the following settings:

o Update the log every x minutes on GV-DVR/NVR, or
e Count Auto Reset on GV-VMS

Based on the specified time interval, the system logs the count data to GV-DVR/NVR/VMS,
which is then sent to the GV-Web Report server via dbSync2.

Note:

1. dySync2 is required only for GV-NVR (V8.3.2 or later) and GV-VMS (V16 to V18) when
people and face counting is performed by the GV-NVR/VMS system itself, rather than
processed on Al-capable cameras.

2. dbSync2 is not supported by GV-VMS V20.

3. To transmit the counting data from Al cameras, connected to GV-VMS, to GV-Web
Report, see 3.4.4 Sending Al Camera Counting Data via GV-VMS.

« On GV-DVR/NVR, configure the Update the log every x Min. option in the
Counter/Intrusion Alarm Setting.

e ]
Counter/Intrusion Ala i E,

—Choose Camera

Caonfigure. .,
Tri7 IMz1 Ca2s C»
Uncheck all
Mis Mzz T2 20
Check all
Frie Mzz Cz7 Ca1 o
F20 T24 28 [ 32 32 Cancel
[~ Update the Log every: m

o I 60 M,

= At each Clock Hour

W Show Object

Figure 3-4

12
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On GV-VMS, configure the Count Auto Reset option in the Counter/Intrusion Alarm

Setting.
= P
Counter | Alam

Choose Camera |

C 1 v )

i amera o\ At
Setting : AT

X o 3

[¥] Enable Setting P mEL

© Define Detection Zones N N :

[&] !
EXEMN o \_ \ L
) Define Object Size A\ TEEmEE - on N \Y

2 s S
@ \ :
%, o . Z A .
- 28
Test Count Counting Result
Sensitivity -— In: 0
3 e el Out: 0
[Door Demo v]
Option
Show Alarm Regions CountAuto Reset
@[5 :
[T skip Frame @ & ‘ | i
Reset Per Hour
[ ok ][ cancel
Figure 3-5

To define a specific time to send people counts to the GV-Web Report server, see 3.4.1
Configuring the dbSync2 Program on GV-DVR/NVR/VMS.

13
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3.4.3 Sending Face Counting Results

To send face counting results from GV-DVR/NVR/VMS to the GV-Web Report, configure the
following settings:
o Enable the Face Count function on the GV-DVR/NVR/VMS.
e Ensure remote access to GV-DVR/NVR/VMS has been enabled on the GV-Web
Report. See 3.7.3 Remote Access Settings for details.

Note: Version requirements and limitations:

1. For GV-DVR/NVR, version 8.4.0.0 or later is required. An AVP dongle is necessary for
versions 8.4.0.0 to 8.5.5.0

2. For GV-VMS, version 16.10 or later is required
3. The Face Count function is not supported by GV-VMS V20.

1. Configure face counting on GV-DVR/NVR/VMS.
*+ On GV-DVR/INVR,

A. Click the Configure button, select Advanced Video Analysis and select Face

Count Setting.
B. Select the cameras you want to configure and click Configure.
« On GV-VMNS,
A. Click Home, select Toolbar, click Configure, and select Video Process.

B. From the Video Analysis dropdown list, select Face Count, select the desired

cameras, and click Setting.

14



This dialog box appears.

v Camera
Camera Selection

Camera 1 ¥

Definition

Face Count @

& Mask Region =N B]_I X
" Detected Face Size

Setting
Alarm Type

Face Count ¥

Reset at 12 o'clock

Sensitivity 3

j—

=

i
s
— e e = =]
@)

-

Schedule ] Test l I@

OK I Cancel

Figure 3-6

2. Select Face Count under Alarm Type.

n Getting Started

In the Option section, select Save counting results to GV-Web Report. A dialog box

Type Domain Name or IP Address, Port, UserName, and Password of the GV-Web

Report. The default port number is 30000. For details on account settings on the GV-

3.
appears.
E:r:nain Name or IP |
Pnan!SR |
UserName I
Password I
Test Cancel
Figure 3-7
4,
Web Report server, see 3.7.2 Account Settings.
5. Click OK.

15
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3.4.4 Sending Al Camera Counting Data via GV-VMS

To transmit people counting results from Al-capable cameras, connected to GV-VMS, to the

GV-Web Report server, follow the steps below.

Note: The video analysis by Al camera is only supported by GV-VMS V18 and V20
versions.

1. In GV-VMS, go to IPCVA settings (Home > Toolbar > Configure > Video Process).
2. To configure the Al camera to send counting data to GV-Web Report:
« For GV-VMS V18
A. Select the camera from the dropdown list, enable People Count, and click
the Arrow button.

B. Select the Detection Region and configure the Counting Reset interval or
time for People Count events. Select Web-report > Setting to establish the
connection to GV-Web Report, allowing real-time data transmission.

IP Cam Video Analysis X
Camerall v

IP Cam video analysis

People Ct

[Jintrusion »
[[ICross Line >
Leave Area >
[ Erter Area >

[ People Count >

Missing Object

Figure 3-8

16
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For GV-VMS V20
A. Select the camera from the dropdown list, enable Object Count, and click the

Arrow button.
IP Cam Video Analysis
Camera3

IP Cam video analysis

Gv 3D People Count Enter Area

Leave Area > Crowd Detection

/ Face Detection Abnormal Audio Detection

Cross Line

Intrusion > /' Object Count

Setting...
Record : Al Cam Settings

Setting

Live Draw Rect
Cancel

Figure 3-9

B. Select the Detection Region and configure Counting Reset interval or time
for Target Counting events. Select Web-report > Setting to establish the
connection to GV-Web Report, enabling real-time data transmission.

Setting X

/ Reset counter on monitoring start 8
Region : R1
Reset

Minute

Manual Rest Reset

/' Web-report

Cancel

Figure 3-10

17
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3.5 Connecting to GV-Smart Box

To send people counts, face counts, and object size counts from a GV-Smart Box to the GV-
Web Report server, you need to configure the GV-Smart Box to allow connection to GV-Web
Report. For details, see the Connecting to GV-Web Report section in GV-Smart Box User’s
Manual.

Note: GV-Smart Box is no longer supported.

1. Select Events and Alerts and then Web Report Setting in the Web interface of the
GV-Smart Box. This page appears.

Web Report

In this section you can configure the connection to Web Report.

Web Report

[#]Enable
Host name or IP Address (182.168.0.123

Fort Mumber 30000
User Mame 1

Fassward .

Connection Status

Status: Connected. Connected TirmeWed Moy 3 11:47:22 2010

Figure 3-11
2. Enable the Web Report function.

3. Enter the IP address of the GV-Web Report server, and the login username and

password.

4. Click Apply.

The Connection Status is shown on the bottom of the page displaying the GV-Web
Report’s connection status and the connection time.
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3.6 The Main Screen of GV-Web Report

8|

#2 GeoVision QV-Web Regort — O *
Sef\aice Elrj:vse TjOIS Help
M = j DESKTOP-52PTBAP A E Evens
7 ?_—.’0”“”&[” Time Account  Device IP Address Action Result
9 E GV-3D People Countt 2047-11-03 19:51:15 1 GV-3D People Counter 192.168.0.252 Device Login. Success
EG\«LVMS—W 2017-11-03 19:51:08 1 @V-3D People Counter 192.1588.0.252 Device Logout Success
- 2017-11-03 19:50:49 1 GV-3D People Counter 192.168.0.252 Device Login. Success
: E% GV-VMS-2 2017-11-03 19:50:44 1 GV-VMS-2 192168.0.2 Device Logout Success
5 Offine(2209) 2017-11-03 19:50:41 1 GV-VMS-2 192.168.0.2 Device Login. Success
- 2017-11-03 19:50:22 1 GVVMS4 192.168.0.50 Device Logout Success
2017-11-03 19:50:09 1 GV-VMS-1 192.168.0.50 Device Login. success
Figure 3-12
No | Name Description
1 Host List Displays connected hosts.
2 Event List Displays the connection information.
3 Service Enables and disables the following GV-Web Report services:
m Data Service: Allows connection to GV-3D People Counters, GV-
DVR/NVR/VMS and GV-Smart Boxes.
B  Web Service: Accesses to the GV-Web Report’s Web Interface.
Allows remote access to live video as well as recordings of GV-
DVR/NVR/VMS, face snapshots captured from GV-Smart Boxes,
and people counting data from GV-3D People Counters.
m  Auto Export Service: Export data automatically based on defined
schedule. See 3.7.7 Exporting the Counting Data.
4 | Browse Links to the Web interface of the GV-Web Report.
5 | Tools Accesses advanced settings. See 3.7.1 General Settings, 3.7.2
Account Settings, 3.7.3 Remote Access Settings, 3.7.4 Database
Settings, 3.7.5 E-Mail Settings, 3.7.6 UPnP Port Mapping Settings.
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3.7 Advanced Settings

To access more settings of the GV-Web Report server, click Tools (No. 5, Figure 3-12) on
the main screen. The following sections describe advanced settings: General Settings,
Account Settings, Remote Access Settings, Database Settings, E-Mail Settings, and UPnP
Port Mapping Settings.

3.7.1 General Settings

The General Settings allow you to configure the communication ports of the GV-Web Report

server and automatic startup services.

) General Setup ot
Data Server

Server Name: DESKTOP-AZATHMK

Listen Port 30000

Counter V3 Listen Port 8830
Max Client Lirnit 100 (Max value is 2550)
B Auto Start Senvice

Web Senver
Listen Port 88

[ Auto Start Sernvice

| Auto Startup Export Service
| Auto startup after login Windows
| Startup Auto Login B

] Auto minimize on startup

Resetto default

Apply

Figure 3-13
[Data Server]

m  Server Name: Defines the name of the GV-Web Report server. The default value is the

computer name.

m Listen Port: The default port value for GV-Web Report is 30000. The port value must
match the GV-Web Report related port on GV-3D People Counter V2 (Figure 3-1), GV-
DVR/NVR/VMS (Figure 3-3) and GV-Smart Box.

m  Counter V3 Listen Port: The default port value for GV-3D Counter V3 connection is
8890. The port must match the Server Port configured on the GV-3D People Counter V3.
To locate the Server Port on the GV-3D People Counter’s Web interface, go to Config >
Network > HTTP POST. For details, see 7. Connecting to GV-Web Report in GV-3D
People Counter V3 Quick Start Guide
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n Getting Started

m  Max Client Limit: Defines the maximum number of GV-3D People Counters, GV-
DVR/NVR/VMS and GV-Smart Boxes that can be connected to the GV-Web Report. The
maximum value is shown on the right.

m  Auto Start Service: Automatically starts connection to GV-3D People Counters, GV-
DVR/NVR/VMS and GV-Smart Boxes once the GV-Web Report server is started.

[Web Server]

m Listen Port: The default port value is 80. The HTTP port enables connecting the GV-
Web Report server to the Web.

m  Auto Start Service: Automatically starts remote access to GV-DVR/NVR/VMS and GV-
Smart Boxes.

m  Auto Startup Export Service: Automatically starts the scheduled data export task after
GV-Web Report launches. See 3.7.7 Exporting Counting Data.

m Auto startup after Windows login: Automatically launches the GV-Web Report server
after Windows startup.

m Start Auto login: Automatically logs into the GV-Web Report server after Windows
startup. Click the Arrow button and enter the login credential of GV-Web Report.

m  Auto Minimize on startup: Automatically minimizes the GV-Web Report window after
GV-Web Report launches.
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3.7.2 Account Settings

The GV-Web Report supervisor can create new accounts with different access rights. The
supervisor account has the privilege to log into the GV-Web Report and make configuration
settings, while the user account is only allowed to access the GV-Web Report Web interface.
The maximum account number for supervisor and user accounts is 100.

Account User Setfting

Users(0) Account
= Supervisors(1) | |

admin

Mew Password

Canfirm Mew Password

| |

General Setup | Gylweh Report

Allowe Web Login
Allow Remate Playback
Allowr Live ‘iew

Figure 3-14

For details on the Allow Group Setting option under the GV-Web Report tab in the Account
dialog box, see 4.2 Group Page.

22



n Getting Started

3.7.3 Remote Access Settings

The Remote Access Settings display available GV-DVR/NVR/VMS systems and GV-Smart
Boxes for remote access to their live video, recordings, and face snapshots through a Web
browser. The asterisk * on the State column indicates the account name and password are

required for access to the specific system or device. To allow remote access, select it on the

list and then type its login account and password.

EE| Remote Access Setting E

Device

State Device Type Diewice IP Address Accaunt
* GEOWISIO-FFFECD 1921682128

* AlexLocalDvR 192168.0.227

* DR 192 168.2.160

* TEST144-DF980IC2 182.168.0.226

* TEST16 192.168.0.186

127.0.0.1

< | @

Remote Access Setting
Comrmand Port: | 4550

|

VideoPort  |5860 |

Audio Port  |B5S0 |

ViewLog Port: 5562 |

Account |1 |
Password |* |
l Reset to default l l Apply ]

Figure 3-15
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3.7.4 Database Settings

You can modify the storage path of the GV-Web Report database, specify the number of
days to keep the database, and change the storage path of face snapshots from GV-Smart

Boxes.

If the computer of the GV-Web Report server is of NTFS file system, you can select Enable
Database Compression to save disk space.

Database

Setting

IAProgram FilesiGea D

{0; unlimited)

Fath

Keep Days 0]

Snapshot Folder: |[AProgram FilesiGeaok D

Figure 3-16

3.7.5 E-Mail Settings

You can send e-mails to the supervisor when the connection of any GV-3D People Counter,
GV-DVR/NVR/VMS or GV-Smart Box is lost. You can also send e-mail notifications when
the pre-defined maximum number of people is reached. See 4.2 Group Page on how to set

the maximum.

at! E-Mail Setting X
E-Mail Setting
SMTP Server:

From

TO

Subject

Test E-Mail Account

SMTP Authentication Setting
[T SMTP Mail Server requires authentication

Account

Password

SMTP Server Setting
SMTP Port 25
[ 85LTLS

oK Cancel

Figure 3-17
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3.7.5.1 Setting Mail Server

1.  Type URL or IP address of the SMTP server.
2. Type the sender e-mail address.

3. Type the recipient e-mail address. For multiple recipients, add a semicolon between
each e-mail address.

4. Type a subject regarding an alert message.

5. Click Test E-Mail Account to send out a test e-mail to see whether the setup is
complete. If not, you may need to check the SMTP Authentication Setting and SMTP
Server Settings described below.

Other options on the dialog box:

[SMTP Authentication Setting] If your e-mail service provider requires an authentication for
sending e-mails, select this option and type your SMTP account ID and password.

[SMTP Server Setting]
m  SMTP Port: Type the SMTP port value. The default value is 25.

m  SSL/TLS: If your e-mail server requires an SSL or TLS authentication for connection,
select this option.

3.7.5.2 Setting E-Mail Alert

When a GV-3D People Counter, GV-DVR/NVR/VMS or GV-Smart Box is disconnected from
the GV-Web Report, the e-mail will be sent out to warn the supervisor. Follow the steps
below to set the e-mail alert.

e Right-click the host in the host list and select Host Setting.

(ﬂ GeoVision GV-Web Report

Service  Browse Tools  Help
= #£5 TESTIS B Events
_;Fg'__- Online(d) Time Account
= B2 offline(2)
=% GW-Srmart Box

GY-Srmart Box-FP

Host Setting

Figure 3-18
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. Enable Send E-Mail Notification when disconnected, and click OK.

Matification |

Send E-Mail Maotification when disconnectad.
E-Mail Setting

Figure 3-19
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3.7.6 UPnP Port Mapping Settings

The GV-Web Report server supports UPnP technology (Universal Plug and Play) to allow
automatic port configuration to your router.

The following requirements must be met to enable UPnP:
e Windows operating system has been configured to use UPnP
e UPnP has been enabled on your router (consult your router's documentation)

To enable UPnP on the GV-Web Report:

1. Click Tools from the menu bar and select UPnP Port Mapping Setting. This dialog box

appears.

UPnP-based Router

MName Port IP Address MOTE
I BV-Weh Report Port 30000 192.168.2.168
_+ Wieb Server Port 8080 192.168.2.168

< 4
20:41:01- Na UPnP devices availahle

20:40:58- Searching for UPnP enabled routers....

Figure 3-20

2. Click Searching to search the UPnP-enabled routers.

3. If your server is installed with more than one router, select a desired one from the UPnP-
based Router dropdown list.

B

If you server is installed with more than one network adapter, select a desired one from
the dropdown list.

5. Click Configure to automatically configure the communication ports on the router.

Tip: If you are not using the default ports, update the corresponding port settings in the
General Settings dialog box (Figure 3-10). Then, re-open the UPnP Port Mapping dialog
box and follow the steps above to configure your router.
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3.8 Exporting the Counting Data

GV-Web Report allows you to export people counting and POS data on a daily, weekly,
monthly, or yearly basis. Data can be delivered via e-mail or saved to a designated local
folder automatically.

B GV-WebReport Auto Exporter == O X
Setting

Email Group
New Export task

Email Group Name:
New Export task

Export Counter Group:
testjoyce v~ Refresh
() Tofolder: Select...

Email Receiavers(one email per line):

geocarytest@gmail.com

Data Source
Cument day v

Daily ~ Weekly Monthly Yearly
People Count
In/Out Counts per hour and Total Stay
Difference between In and Out per hour
Total In/Out and Stay per hour

POS
Sales per hour Visitors per hour
Transactions per hour Conversion per hour
Avg. Sales per hour Avg. Customer Value per hour
Send now Save
Figure 3-21

To access the function, follow the steps below”
1. Click Service on the menu bar > Auto Export Service.

2. If the e-mail server has not been configured, you will be prompted to configure the
SMTP Settings.

3.  Onthe GV-Web Report Auto Export dialog box, right-click Email Group > New Export
Task.

4. Configure the following settings on the dialog box:
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m  Email Group Name: Assign a name to the export task.

m  Export Counter Group: Select a counter group for export. To create groups, see 4.2
Group Page.

m To Folder: Specify the local file path to save the exported data.

m  Email Receivers: Enter email address(es) to receive the exported data.
m Data Source: Select the data of Previous day or Current day to export.
m Daily, Weekly, Monthly, Yearly: Select the export frequency.

m  People Count: Select the specific people counting data to export.

m  POS: Select the specific POS data to export.

5. Click Send now to export immediately, or Save to save the settings.

The exported data is available in the .CVS and .pdf formats.

To automatically start the scheduled export task after GV-Web Report launches, enable the
Auto Startup Export Service function under General Setup. See 3.7.1 General Settings.
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3.9 Accessing the Web Interface

To access counting results through the Web interface, ensure that Web Service on the GV-
Web Report server has been enabled as shown below.

“. GeoVision GV-Web Report

Service | Browse Tools Help

Start all services

Stop all senvices

[v| DataSenice ery3
¥ | Web Senice |
Z Auto Export Service
Logout
Exit
Figure 3-22

1. Two methods to access the Web interface of GV-Web Report:

A. If you are using the local GV-Web Report server, select Browse on the main screen
of the GV-Web Report (No. 4, Figure 3-12) and select GV-Web Report Data. The
login page appears.

X ar

192.168.4.156/Geo_Login.php? LANGUAGE=EN

(2 geovision

Sign In with your account
Language: | English

password:
Enter the characters - 332 1

shown in the image

] Remember my Account and Password

©2025 GEOVISION INC.ALL RIGHTS RESERVED.

Figure 3-23

B. If you are using a remote computer, open a Web browser and enter the IP address or
domain name of the GV-Web Report in the browser. The login page appears.

2. Type the login ID and Password of the GV-Web Report.

3. Type the characters shown in the image.
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4. Click Login. The Web page is now displayed on your browser.

(2 6eovision GV-Web Report - People Counting

@ : On Line
= Total List
» DESKTOP-6SKULPM®@[Delete]

» GV-3D People Counter@[Delete]
Counting Signage

8 : Off Line

DESKTOP-6SKULPM
In 45

GV-3D People Counter
In

395

» Cameral(Live View)

» Camera3(Live View)
» Camera4(Live View)
» Camera7(Live View)

Total In: 440 | Total Out: 381 | Stay: 59 | Wrong Direction Count: 0
» Total In{Out): on behalf of today 0:00 until now In(Qut)

« Update Frequency : 60 sec
+ Last Updated : 16:40:16
« 7 Seconds later update

Total Device Real-time In and Out chart

7

&0
tow
5

4

Figure 3-24

After starting GV-Web Report Service, you can access the counts, graphics and live video

on the network. The GV-Web Report is organized into five pages, which can be selected

from the upper-right corner of the interface. These pages are listed in the table below:

No.

Counting Pages

Description

People Counting

provides counting data regarding the number of people
stepping in and out as well as the number of people
remaining in the surveillance area from GV-3D People
Counters, GV-DVR/NVR/VMS and GV-Smart Boxes. See
Chapter 4 People Counting Page.

Face Counting

provides face counting data, and gender and age
recognition results of people in the surveillance area from
GV-DVR/NVR/VMS and GV-Smart Boxes. See Chapter 5
Face Counting Page.

POS Information

provides statistical data regarding the total and average
sales amount, the number of transactions, visitors,
conversion and average customer value in the surveillance
area from GV-DVR/NVR/VMS. See Chapter 6 POS
Information Page.

Heat Map Information

provides the visualized traffic data about the level of motion
intensity detected in the surveillance area. This function is
only supported by GV-VMS. See Chapter 7 Heat Map
Information Page.

Object Size Counting

provides counting data of vehicles in the surveillance area
sorted by different object sizes from GV-Smart Boxes. See
Chapter 8 Object Size Counting Page.
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Chapter 4 People Counting Page

The People Counting page provides counting data regarding the number of people in, out
of, and remaining in the surveillance area. The counting data can be acquired from GV-3D
People Counters, GV-DVR/NVR/VMS and GV-Smart Boxes.

2 user: admin T Logout

L ] -
(2 GeoVision GV-Web Report - People Counting

Figure 4-1

4.1 Device Page

On the Device page, you can access three types of people counts of the current day.

Main page On the main page of the Device page, the people counts of the
current day are updated from the GV-Web Report server every
minute. See 4. 1.1 Viewing People Counts Updated Every Minute.

Counting Signage On the Counting Signage page, the people counts of the current
day are updated from the GV-Web Report server immediately. See
4.1.2 Viewing the Current People Counts.

Live View Window On the Live View window, the people counts are updated directly
from GV-DVR/NVR/VMS. You can also view live video from GV-
DVR/NVR/VMS or GV-Smart Box. See 4.1.3 Viewing Live Video.
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4.1.1 Viewing People Counts Updated Every Minute

The data on the main page of the Device page is updated every minute from the GV-Web
Report server. The page displays the people counts and graphs of all connected GV-3D
People Counters, GV-DVR/NVR/VMS and GV-Smart Boxes.

(& 6eovision GV-Web Report - People Counting

Device | Group | Log | Query | Custom Query User: admin  Logout

8 :onLine ®:0OffLine

= Total List GV-3D People Counter left GV-3D People Counter GV-3D People Counter right
In 0 In 0 In

> GV-3D People Counter left@[Delete] 324
> GV-3D People Counter@®[Delete]

> GV-3D People Counter right@ 0 0
[Deleta]
Counting Signage

Total In: 324 | Total Qut: 309 | Stay: 15 | Wrong Direction Count: 0

Out 0 Out 0 Out 309

s Update Frequency : 60 sec
e Last Updated : 18:17:59
s Total In{Out): on behalf of today 0:00 until now In{Out) s 14Seconds later update

Total Device Real-time In and Out chart
50

Figure 4-2

The counts on the main page show:

B In: The number of people entered during the day.

m  Out: The number of people left during the day.

m Total In: The total number of entered people detected from multiple devices during the
day.
Total Out: The total number of left people detected from multiple devices during the day.
Stay: The number of remaining people, the subtraction of Total Out from the number of
Total In.

®  Wrong Direction Count: The total number of people moving in the wrong direction
during the day.

33



Q GeoUision:

On the left menu, you can find these options:

Q GeoUision

GV-Web Report - People Counting

Device | Group | Log | Query | Custom Query

User: admin  Logout

@ :0nline ®:0ffLine

i—Total List

» GV-3D People Counter@®
Delete]

» GV-Smart Box@[Delete]

» TEST-308-PC@[Delete]
> Cam 1{Live View)
> Cam 2{Live View)
> Cam 3{Live View)
» Cam 4{Live View)
» Cam 5{Live View)
» Cam 6(Live View)
» Cam 7{Live View)
» Cam 8{Live View)
> Cam 9{Live View)
> Cam 10(Live View)
> Cam 11(Live View)
> Cam 12(Live View)
» Cam 13(Live View)
» Cam 14(Live View)
» Cam 15(Live View)
» Cam 16(Live View)
Counting Signage

» CAMERA_NAME(Live View)

ST-308-PC V-Smart Box GV-3D People Counter

Count: 0

In 0 In 22,345 In 1, 362
Qut Out 13,041 Out
Stay Stay 9,304 Stay 1,307

Total In: 23,707 | Total Out: 13,096 | Stay: 10,611 | Wrong Direction

« Total In{Out): on behalf of today 0:00 until now In{Out)

+ Update Frequency : 60
sec

+ Last Updated : 18:48:14
+ 45Seconds later update

4,000

2,500

2,000

2,500

Total Device Real-time In and Out chart

N\

(] 1 2 3 4 5 6 7 1 9

e —

'-.—-—--—-_/

10 11 12 13 14 15 1s 17 13

Figure 4-3

m Total List: Select one device under the list to access its individual counts. A green mark
indicates that the device is now updating data to the GV-Web Report server; otherwise a
red mark appears. On the individual device’s page, the people counts of the current day
are updated every minute from the GV-Web Report server. To remove a device from the

list, click Delete next to the device name.

©® Camera: Access the live video if remote access function is enabled on both the
device and GV-Web Report server. See 4.1.3 Viewing Live Video.

m  Counting Signage: Access the people counts of the current day updated immediately
from the GV-Web Report server. See 4.1.2 Viewing the Current People Counts.
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n People Counting Page

To view the people counts of the current day continuously updated from the GV-Web Report

server, select Counting Signage from the left menu of the Device page.

£ hip:/102.160.5.242/pp/Cavater_Signage php?TTPE-ALLDEVICE

In

GV-3D People
Counter left-

0

In

0

GV-3D People
Counter-

In

GV-3D People
Counter right-

326

Out

0

Out

o

QOut

313

Stay

0

Stay

BN:In/0: ot

[ Enable Alarm Sound

0

Stay

13

Recently Record(20 Records)

Device Name Time In Out Wrong Direction Count
GV-3D Peaple Counter right 2013-11-07 18:24:17 0 1
GV-3D Peaple Counter right 2013-11-07 18:23:44 0 1
GV-3D Peaple Counter right 2013-11-07 18:23:12 1 0
GV-3D Peaple Counter right 2013-11-07 18:22:17 1 0
GV-3D People Counter right 2013-11-07 18:19:43 1] 1

Figure 4-4
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4.1.3 Viewing Live Video
To access live video, select the desired camera from the left menu of the Device page. To
enable video streaming, ensure the following settings have been configured:

e GV-DVR/NVR/VMS: Enable WebCam Server, and configure DVR Configuration for
Remote Access in dbSync2 (Figure 3-3).

e GV-Web Report: Enable Remote Access settings (3.7.3 Remote Access Settings)

= Start Time
2009412423 15:04:10

" |n
11

= Qut
6

= Stay People

Figure 4-5

By clicking the Start button on the Live View window, you can view the updating counts from
the GV-DVR/NVR/VMS.

Note:

1. The In and Out counts on the Live View window is updated directly from the GV-
DVR/NVR/VMS instead of the GV-Web Report server.

2. Once the counts are logged into the GV-DVR/NVR/VMS, the In and Out counts will
become zero and the GV-DVR/NVR/VMS will start counting those numbers again.

3. The live view function is supported only via IE or Microsoft Edge in IE mode.
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4.2 Group Page

n People Counting Page

On the Group page, you can group different cameras from different GV-3D People Counters,
GV-DVR/NVR/VMS and GV-Smart Boxes, and see the people counts of the set group. You

can also set up the maximum number of people entered, left and remaining to activate the

computer alarm. The /O trigger and e-mail notification can also be activated when the

number of people remaining reaches the pre-defined maximum.

To set up a group:

1. Select Add Group from the left menu of the Group page. This page appears.

 Geatis ;
GeoUision GV-Web Report - People Counting
1] StomlCnen People Counting
> [[1Areag4404 Group
> (L Areastodo DESKTOP-6SKULPM
» [1Group94704 Ccamera 4
[camera12
Manage Group Camera [Jcamera13
» Add Group [ camerazo
» Maintain Group Camera 22
- O
» Setting Group Relations amera
Setting Group Relati Hc 23
Manage Email Group In Maximum
» Add Email Group out Maxi
» Maintain Email Group ut Maximum
Manage [/ Device Stay Maximum
» Add 1/0 Device Country v
» Maintain I/O Device City
Counting Si = =
» ounting Signage Set email for reaching the maximum CUyes ®nNo
Set IO trigger for reaching the maximum | O Yes ® No

Name the group.
Select the cameras that you want to include in the group.

In the In Maximum field, set the maximum number of people that can enter during the
day before activating the computer alarm.

In the Out Maximum field, set the maximum number of people that can leave during the
day before activating the computer alarm.

In the Stay Maximum field, set the maximum number of people that can remain during
the day before activating the computer alarm, sending a notification e-mail or triggering
an output device.

Select a Country and a City to specify your location if you are in Taiwan and China.

To receive e-mail notifications when the maximum number of people remained is
reached, select Yes for Set email for reaching the maximum.

To trigger an output device when the maximum number of people remained is reached,
select Yes for Set I/O trigger for reaching the maximum.
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10. Click Submit.

11. From Total List in the left menu, select the set Group to see the sum of every people

count from the selected cameras.

On the left menu of the Group page, you can find these options:

B Total List: Access the people counts of the set groups updated every minute from the
GV-Web Report server.

B Counting Signage: Access the people counts of the set groups updated immediately
from the GV-Web Report server. When the limit of In Maximum, Out Maximum or
Stay Maximum is reached, the warning texts will be displayed on the page and the

computer alarm will be activated too.

B Setting Group Relations: Drag and drop a group under another group to make a

subgroup.
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To set up e-mail notifications:

To receive e-mail notifications when the maximum number of people remaining is reached,
you must first set up the mail server on the GV-Web Report server, and then set up an e-
mail group as below. To set up the mail server to send e-mails, see 3.7.5 E-mail Settings.

1. Select Add Email Group from the left menu of the Group page. This page appears.

° . L
(2 6eovision GV-Web Report - People Counting
D Gro - n B custom uery People Counting v
» [ Areaga404 Email Group
> [ Aread8040
> (1 Group94704 Group member email
e
» Add Group
» Maintain Group
» Setting Group Relations
Manage Email Group
» Add Email Group
» Maintain Email Group
Manage 1/0 Device
» Add 1/0 Device
» Maintain I/O Device
» Counting Signage
Figure 4-7

2. Name the group.

3. Inthe Group member email field, type the E-mail address to sent notification to.
Separate multiple e-mail addresses with semicolons.

4. Click Submit.

5. Click Maintain Group to customize the e-mail subject and content. And then click the

Update Group button@. Type new e-mail subject and content.

6. Select Maintain Email Group to edit an existing e-mail group. And then click the Update

Group button@. Click the Delete Group button @ to delete an existing group.
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To set up I/O triggers:

The /O trigger warns the onsite operator of the GV-Web Report server when the number of
people remaining reaches the pre-defined maximum. The I/O trigger function only supports
GV-I/O Box 4/8/16 Ports.

Note: The I/O trigger function only supports one output device through a GV-1/0 Box, and
the GV-1/0 Box needs to be connected to the COM port of the GV-Web Report server.

1. Select Add I/0 Device from the left menu of the Group page. This page appears.

People Counting

(2 GeaVision GV-Web Report - People Counting

Device | Group | Log | Query | Custom Query

User: admin  Logout

-
> 0122 Device Name GVIO-USB(8) v
Manage Group port com_v|
> Add Group Address [1v]

> Maintain Group Output __[Signal Type

Onjo Onjopulse|  lsec

> Setting Group Relations

Manage Email Group Foutputt
» add Email Group Onjc @njcpuses  |sec
> Maintain Email Group Onjo Onopuse|  Jsec

Manage 1/0 Device [ output2 o

N/C @N/CPulse|5s  Sec
A6 110 Bevice o Oncruels |
» Maintain 1/O Device Hloupus Onjo Onjopuise| sec
» Counting Signage Onjc @n/cpulse|s  sec
Onjo Onjopulse|  [sec
[ outputa Onje ®
output N/C @N/CPuse|5  [Sec

Onjo Onjopulse|  se
Outputs

Onjc @njcpuses  [sec

Owjo Onjopulse|  sec
Outputs

Onjc @njcpulsels  sec

Owjo Onjopulse|  lsec
Output?

Onjc @n/cpuses  |sec

Onjo Onjopulse|  lsec
Outputs

Onjc @njcpulse|s  sec

Figure 4-8
2. Select the device name from the dropdown list.
3. Select the corresponding COM port and address for the 1/0 device.

4. Select the output to trigger and select its signal type. For the Pulse type, specify the
amount of time in second you want the output device to be triggered for.

5. Click Submit.
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4.3 Log Page

On the Log page, you can view the people counts of a specified time period from GV-3D
People Counters, GV-DVR/NVR/VMS, and GV-Smart Boxes.

(2 Geovision GV-Web Report - People Counting

@ pevice | Broup | M 1og | ' Query | B custom Query

=» Logout

A User: admin

The page show record 1-15 , total number of records : 41,926

DESKTOP-DMUOM2A (B
DESKTOP-DMUOM2A [
DESKTOP-DMUOM2A (M
DESKTOP-DMUOM2A [l
DESKTOP-DMUOM2A (8
DESKTOP-DMUOM2A [l
DESKTOP-DMUOM2A [
DESKTOP-DMUOM2A [l
DESKTOP-DMUOM2A [
DESKTOP-DMUOM2A (B
DESKTOP-DMUOM2A [
DESKTOP-DMUOM2A [
DESKTOP-DMUOM2A [l

Cam4 2015-11-09 11:22:39 2015-11-09 11:23:39 19 11
Cam 3 2015-11-09 11:22:39 2015-11-09 11:23:39 19 11
Cam 3 2015-11-09 11:23:39 2015-11-09 11:24:39 16 9
Camd4 2015-11-09 11:23:39 2015-11-09 11:24:39 17 8
Cam4 2015-11-09 11:24:39 2015-11-09 11:25:39 14 9
Cam 3 2015-11-09 11:24:39 2015-11-09 11:25:39 14 9
Cam 3 2015-11-09 11:25:39 2015-11-09 11:25:47 5 0
Camd4 2015-11-09 11:25:39 2015-11-09 11:25:47 5 0
Cam 3 2015-11-09 11:26:39 2015-11-09 11:27:39 12 14
Cam 4 2015-11-09 11:26:39 2015-11-09 11:27:39 12 13
Cam 3 2015-11-09 11:27:39 2015-11-09 11:28:39 15 15
Cam4 2015-11-09 11:27:39 2015-11-09 11:28:39 15 15
Cam4 2015-11-09 11:28:39 2015-11-09 11:29:39 20 14

O : X v
il e s [N ot mumber of pases 2795
Start Time: 00 v |00 v |00 v Query Result List
End Time: 23 v | 50 v /5O ¥ Device Name Camera Start Time End Time In Qut Wrong Direction VIDEO CLIP
DST: © Select All ¥ N DESKTOP-DMUOM2A (M Cam 4 2015-11-03 10:19:35 2015-11-09 11:22:39 19 12
Type: Log v DESKTOP-DMUOM2A M Cam 3 2015-11-03 10:19:35 2015-11-09 11:22:39 20 12

IDNDODDDODDDDODODmm

E @ 8]

Figure 4-9

To search the log data:

1. Select a specific GV-3D People Counter, GV-DVR/NVR/VMS, and GV-Smart Box from
the Device dropdown list or a created group from the Group dropdown list.

2. Specify Start Time and End Time of the log data.

3. You can select whether to search the DST (Daylight Saving Time) data. Select All
indicates searching all data including DST data, Y indicates searching only DST data
and N indicates not searching DST data.

4. To see people counting results within the Start Time and End Time, select the Type
dropdown list:

e Log: Shows the total number of In, Out, and Wrong Direction and Video Clips on an
one-minute basis.

e Subtotal: Shows the total number of In, Out, and Stay on an one-hour basis.

e 10 Minutes: Shows the total number of In and Out and Wrong Direction on a 10-
minute basis.
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e GPS: Shows latitude and longitude of GV-3D People Counters.

G :
GeoUision GV-Web Report - People Counting
" 3 -
@ pevice | B croup | Miog | W Query | B custom Query A User: admin Logout
® Device: GV-3D People Counter v The page show record 1-15 , total number of records : 18,352
a Al e >> total number of pages : 1,224
roup: \
Start Time:  [2015-10-7 ﬁ 00 v |00 v}:00 ¥ Device Name Time Latitude Longitude
" GV-3D People Counter 2015-11-14 08: X 25.081995 0.0
. v|{50 v|[50 v
End Time: 23 159 159 GV-30 People Counter 2015-11-14 . 25.081995 0.0
Type: GV-3D People Counter 2015-11-14 08: 25.081995 0.0
GV-3D People Counter 2015-11-14 08: 25.081995 0.0
Subtotal GV-3D People Counter 2015-11-14 08: 25.081995 0.
10 Minutes GV-3D People Counter 2015-11-14 25.082069 121.566704
GV-3D People Counter 2015-11-14 25.081995 121.566658
GV-3D People Counter 2015-11-14 . 25.081995 121.566658
GV-3D People Counter 2015-11-14 08:35: 25.081976 121.566643

Figure 4-10 Search results showing GPS data

5. Click Query to display the search results.

To back up the search results in EXCEL, WORD or PDF format, click the icons &/ = | B gt
the bottom of the Query Result List.
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4.3.1 Playing Back Recordings

To retrieve recordings, click the Video Clip icon on the Log page. The following playback
window will appear. To have video streaming, ensure the following settings have been

configured or enabled:
e dbSync2: DVR Configuration for Remote Access configured (Figure 3-3)
e GV-DVR/NVR/VMS: WebCam Server with the Run Viewlog Server option enabled
e GV-Web Report: Remote Access settings configured (Figure 3-15)

Note: The playback function is supported only via IE or Microsoft Edge in IE mode.

Note: The GV-3D People Counter and the GV-Smart Box do not support the playback
function.

Playback

2: Camera 4

6/8/2003 20:48:37 877

“ »
“ »

Figure 4-11

Playback scroll

’ — Move to prev 5 min

Move to prev 1 min

Play — W Il B | @« » o

Pause | Move to next 1 min
Stop \— Move to next 5 min
Home End
Backward Forward
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Right-click the playback window to see the following features:

Play Mode

Includes these options:

Frame by Frame: Play back video frame by frame.

Real Time: Play back video on real time. This mode saves time to
wait for rendering, but may drop frames to provide the visual aspect
of real-time playback.

Key Frame: Play back video with key frame only.

Smooth Playback: Smoothen the video playback when frame
dropping occurs.

Play Speed: Play back video with a designated speed. The options of
0.25x/0.5x / 1x/ 2x [ 4x | 8x are available.

Auto Play Next 5 Minutes: Play back video up to 5 minutes.

Audio: Turn on or off the video sound.

Render

Includes these options:

Deinterlace: Convert the interlaced video into non-interlaced video.

Scaling: Smoothen the possible mosaic squares when enlarging a
playback video

Deblocking: Remove the block-like artifacts from low-quality and
highly compressed video.

Defog: Enhance image visibility.
Stabilizer: Reduce camera shake.

Text overlay’s camera name and time: Overlay camera name and
time onto the video.

Text overlay’s POS/GV-Wiegand: Overlay POS or GV-Wiegand
Capture data onto the video.

Wide angle lens dewarping: Reduce the warping of playback.

Fisheye: Play back video with Fisheye view or enable the Fisheye
Options. For details, see 3.2.2 Fisheye View in GV-Fisheye Camera’s
User Manual. This function is supported by GeoVision fisheye
cameras only.

Mega Pixel View: Enable the PIP or PAP view.
Full Screen: Switch to the full screen view.

Heat Map: Overlay heat map results onto the video.
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Tools

m  Snapshot: Save a video image.
m Save as AVI: Save a video as avi format.

m Download: Download the video clip to the local computer.
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4.4 Query Page
The Query page provides you with the daily, weekly, monthly and yearly people counting

graphs and tables.

To search the counting data, select a GV-3D People Counter, GV-DVR/NVR/VMS or GV-
Smart Box from the Device dropdown list or a created group from the Group dropdown list,

specify a date, and select the options below. Use the Chart dropdown list ‘Ch&m Line Graph & ‘to
choose to display the data in bar graph, pie graph or line graph.

Note:

1. The graphs are displayed with HTML5. For best display performance, use Microsoft
Internet Explorer 7 or above.

2. Pie graph is not available for the following types of data:
e |n/Out Counts per hour and Total Stay
e Total In, Out and Stay per Hour
e In Counts per Hour
e Out Counts per Hour
o Total Stay per Hour

[Daily Report] Display the counting report of the specified date.

m [In/Out Counts per hour and Total Stay: The hourly number of people entered and left,
and the total number of people remaining until now.

m Difference between In and Out per hour: The hourly number of people remaining.

m Total In, Out and Stay per hour: The total number of people entered, left and remaining
during the day.
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The following figure is an example of the In/Out Counts per hour and Total Stay option.
The value 36,103 indicates the total number of departing people, while 48,225 indicates the
total number of entering people between 9 am and 12 am. The statistics shows an increase
in the number of people staying until 10 am.

Ayser: admin " Logout

(2 Geovision GV-Web Report - People Counting
) .

1B cusiom ouen People Counting v

C

Chart ¢ [Line Graph v ~
O Group: All v [2017-10-03] InfOut Counts per hour and Total Stay(All Device)
Time interval: ~ W 300,000 4
T
In/Out Counts per hour and Total Stay 250,000 4
Difference between In and Out per hour
Total In, Out and Stay per hour 200,000
Weekly Report(2017-09-27~2017-10-03) M Total Stay 304,553
Monthly Report(2017-09-03~2017-10-03) o0t H In 48,225
Yearly Report(2016-10-04~2017-10-03) Out 36,103
100,000 / \
50,000 / \
@)
T To=Te sl TS eleanl) fr st | U T 7 P T
o 3 ] L) 12 15 128 21
B n W Out M Total Stay
Time In out Total Stay
0:00 117,079 87,861 29,218
1:00 116,916 87,702 58,432
2:00 117,062 87,809 87,685
3:00 116,975 87,764 116,896
4:00 117,148 87,883 146,161
5:00 117,359 88,112 175,408
6:00 117,073 87,821 204,660
7:00 117,177 87,930 233,907
8:00 117,094 87,841 263,160

Figure 4-12

[Weekly Report] Displays the weekly report that contains the data of 7 days before your
specified date.

® In Counts per hour: The hourly number of people entered for the week.

®  Out Counts per hour: The hourly number of people left for the week.

m Total Stay per hour: The hourly number of people remaining for the week.

m In Percentage per day: The daily percentage of people entered for the week.

m In Percentage per hour: The hourly percentage of people entered for the week.

m Stay Percentage per hour: The hourly percentage of people remaining for the week.
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The following figure is an example of the In Percentage per hour option. The value 13:00,
23.81% indicates the total number of entered people at 13 pm every day for the week is 20.

The number takes up 23.81 percent of the total people entered for the week.

Q GeoUision

® Device:
O Group: All v

[Time interval: ~
Daily Report(2017-08-25)

Weekly Report(2017-08-19~2017-08-25)

In Counts per hour

GV-Web Report - People Counting

Chart : |Pie Graph Vv

People Counting v

Out Counts per hour

Total Stay per hour

In Percentage per day

In Percentage per hour

Stay Percentage per hour

Monthly Report(2017-07-26~2017-08-25)
Yearly Report(2016-08-26~2017-08-25)

[2017-08-19~2017-08-25] In Percentage per hour(All Device)

M 13:00 23.81%

W 13:00

Time

Percentage%

13:00

20!

23.81

16:00

64/

76.19

Sum

84

100

T E) = 8]

Figure 4-13

[Monthly Report] Displays the monthly report that contains the data of 30 days before your
specified date.

In Percentage per day: The daily percentage of people entered in the month.

In Percentage per hour: The hourly percentage of people entered in the month.

m Stay Percentage per hour: The hourly percentage of people remaining in the month.

[Yearly Report] Display the yearly report that contains the data of 365 days before your
specified date.

In Percentage per month: The monthly percentage of people entered in the year.

m  Out Percentage per hour: The hourly percentage of people entered in the year.

m Stay Percentage per hour: The hourly percentage of people remaining in the year.
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4.5 Custom Query Page

The Custom Query page allows you to look up the counting data during a specific period of
time. You can customize the X Axis and Y Axis of the line graph.

1. Select a GV-3D People Counter, GV-DVR/NVR/VMS or GV-Smart Box from the Device
dropdown list or select a created group from the Group dropdown list
Set a Start Time and End Time to filter the counting data.

3. To include only the data from specific time and days of the week, click Setting next to

Work Date. This window appears.

N orkdatesettng

sun) |06 v|: |06 v| |14 v|. 05 v

<

=

Mon) |UU V|:|UU V|~|24 V|:

Tue) [00 9]+ [00 9] - [2¢ 9]

=

=

Thuy |00 %] . 00 »| . [24 ~].

=

ey [0 ][00 ] [24 ).

<

=

(
(
(
(wed) [00 %] [00 %] .. [24 ¥].
(
(
(

s [00 ][00 ] - [22 ] :

Cose Window

Figure 4-14

Specify the days of week and time range to include and click Submit.
5.  You can set the Y Axis of the line graph to the following options:

B In: Shows the average number of people entered.

B Out: Shows the average number of people exited.

B Stay: Shows the average number of people remaining.

B Total In: Shows the total number of people entered.

B Total Out: Shows the total number of people exited.

B Total Stay: Shows the total number of people remaining.

6. You can set the X Axis of the line graph to display the counting data by hour, day,
month or year.
7. Click Query to see the line graph.
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In the example below, In is selected for Y Axis and Per Hour is selected for X Axis. The

value 13 indicates that the number of people entered during 11:00 — 13:00 pm is 13.

50

O . Select All
Device:

® Select All
Group: 123

)

Time: W‘ 00[v]

End

Time: 59]"‘597@
Work date: Setting

Y Axis:

X Axis:

ser: admin

14,000 -

12,000

10,000 ~

8,000

6,000 -

4,000

2.000

In(per hour)

B GvWeb Client-18-1 14,143

M GVWeb Client-18-1

Logout

Figure 4-15
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Chapter 5 Face Counting Page

The Face Counting page provides face counting data, and gender and age recognition
results of people entered the surveillance area. The counting data can be from GV-
DVR/NVR/VMS and GV-Smart Boxes.

After logging in the Web interface, click the Face Counting tab on the upper right corner of
the Web page.

2 user: admin T Logout

(2 Geouision GV-Web Report - Face Counting

@ pevice | n Group | & Log | L Query | B custom Query Face Counting

Figure 5-1

Note:

1. Functions involving age and gender recognition results are only functional when
connecting to GV-Smart Boxes using firmware version 1.0.

2. The Face Counting function is only supported in GV-DVR/NVR version 8.4.0.0 or later
and GV-VMS version 15.10 or later.

3. The Face Count function is not supported by GV-VMS V20.

5.1 Device Page

On the Device page, you can access two types of face counts of the current day.

Main page On the main page of the Device page, the face counts of the
current day are updated from the GV-Web Report server every
minute. See 5.1.1 Viewing Face Counts Updated Every Minute.

Live View Window On the Live View window, you can view live video from a GV-Smart
Box or GV-DVR/NVR/VMS. See 5.1.2 Viewing Live Video.
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5.1.1 Viewing Face Counts Updated Every Minute

The data on the main page of the Device page is updated every minute from the GV-Web
Report server. The page displays the face counts and graphs of all connected GV-Smart
Boxes and GV-DVR/NVR/VMS.

@ eotisi :
GeoUision GV-Web Report - Face Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
8 :0nLine ®:0Off Line
est-s00-pc | Gv-30 poople counter
N Face Face Face

» GV-3D Peop\e:c_:unlterﬂrDelete] counts 122 mrs M counts |2

> GV-Smart Eloy.‘_,DGI_- ete] Mmale |0 Male |0 Male |0

» TEST-308-PC@[Delete] Female o Female D Female |0

nja_ |120 nfa |0 na_ |0

Total Male Count: 0 | Total Female Count: 0

« Total Male(Femalg): on behalf of today 0:00 until now male(female) count : tlapsdtaﬁig;ig;e:nfg::zg?lgec

» 44Seconds later update

Total Device Real-time Male and Female of Time-Sharing chart

Figure 5-2

The counts on the main page show:

m  Face counts: The number of people entered and counted based on face images during
the day.

Male: The number of males entered during the day.

Female: The number of females entered during the day.

n/a: The number of entered people whose gender failed to be recognized.

Total Male Count: The total number of males entered from multiple GV-Smart Boxes
during the day.

Total Female Count: The total number of females entered from multiple GV-Smart
Boxes during the day.

On the left menu, you can find these options:

m Total List: Select one GV-Smart Box or GV-DVR/NVR/VMS under the list to see its
individual face counts. A green mark indicates that the device is now updating data to the
GV-Web Report server; otherwise a red mark appears. On the individual device’s page,
the face counts of the current day are updated every minute from the GV-Web Report
server. To remove a device from the list, click Delete next to the device name.
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© Camera: Access the live video if remote access is enabled on both the device and
GV-Web Report server. See 5.1.2 Viewing Live Video.

(2 Geovision GV-Web Report - Face Counting

e | Group | Log | Query | Custom Query User: admin Lo

@ :0OnLine @ : Off Line
> Total List TEST-308-PC

> GV-3D People Counter@[Delete] Face counts 124
> GV-Smart Box@®[Delete] Male 0
[Delete] Female 0

> Cam 1(Live View) n/a 124

> Cam 2(Live View)
> Cam 3(Live View)
> Cam 4(Live View)
> Cam 5(Live View)
> Cam 6(Live View)
> Cam 7(Live View)
> Cam 8(Live View) TEST-308-PC Real-time Male and Female of Time-Sharing chart =
> Cam 9(Live View)

> Cam 10(Live View)
> Cam 11(Live View)
> Cam 12(Live View)
> Cam 13(Live View)
> Cam 14(Live View) &0
> Cam 15(Live View)
> Cam 16(Live View) 50

Total Male Count: 0 | Total Female Count: 0O

e Total Male(Female): on behalf of today 0:00 until now male(female) count : t’g:f&ig;gg%nfg:é;%gec

e 53Seconds later update

Figure 5-3
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5.1.2 Viewing Live Video

To access live video, select the desired camera from the left menu of the Device page. To
enable video streaming, ensure the following settings have been configured:
e GV-DVR/NVR/VMS: Enable WebCam Server, and configure DVR Configuration for
Remote Access in dbSync2 (Figure 3-3).
GV-Web Report: Enable Remote Access settings (3.7.3 Remote Access Settings)

Note: The live view function is supported only via IE or Microsoft Edge in IE mode.

13:39:39 Play

e =2010/06/15 13:39:39
:)
GEOVISI@N

Figure 5-4

By clicking the icon on the Live View window, you can view the live video from the GV-
Smart Box or GV-DVR/NVR/VMS.
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5.2 Group Page

On the Group page, you can group different cameras from different GV-Smart Boxes and
GV-DVR/NVR/VMS, and see the face counts of the set group.

To set up a group:

1. Select Add Group from the left menu of the Group page. This page appears.

G :
GeoUision GV-Web Report - Face Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
[ Total List Add Group
Group
Manage Group
GV-5mart Box
» Add Group Camera
v
> Maintain Group CAMERA_NAME
» Setting Group Relations
Figure 5-5

Name the group.

2
3. Select the cameras that you want to include in the group.
4. Click Submit.

5

From Total List in the left menu, select the set Group to see the sum of every face count
from the selected cameras.

On the left menu of the Group page, you can find these options:

B Total List: Access the face counts of the set groups updated every minute from the
GV-Web Report server.

B Manage Group:
© Add Group: Select this option to set a group.
® Maintain Group: Select this option to modify the group setting or delete a group.

© Setting Group Relations: Drag and drop a group under another group to make it a
subgroup.
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5.3 Log Page

On the Log page, you can view the gender and age recognition results of a specified time
period and the snapshots from GV-Smart Boxes and GV-DVR/NVR/VMS.

. - B
(2 6eoUision GV-Web Report - Face Counting
Device | Group | Log | Query | Custom Query
® The page show record 1-3 , total number of records : 3
o Il v total number of pages : 1
evice!
O Group: . gwyReswrtee |
Gender: |All v Device Name Camera Start Time End Time Gender Age Ség;fﬁot
Age: |All W GV-Smart Box- 2010-05-28 2010-05-28 N/A
start[2010-05-28 =1 [00 ~ |00 v : v CAMERA_NAME 14:11:31 05:10:23 WA W] 0~50-6 & aQ
Time: [gg GV-Smart Box- 2010-05-28 2010-05-28 N/A
TRy A v1 CAMERA_NAME & 14:11:31 05:11:21 WA w| |O~E0-8 @ =
05~ 359 1 9:
End Time: ’ ’ GV-Smart Box- 2010-05-28 2010-05-28 Male 60~65
=0 1 CAMERA_NAME & 14:11:31 05:11:21 Male 60 ~65 v =
DST: @ select Al Oy ON
= 2 @l

Figure 5-6
To search the log data:

1. Select a specific GV-Smart Box or GV-DVR/NVR/VMS from the Device dropdown list or
a created group from the Group dropdown list.

2. Specify Gender and Age of the log data.
3. Specify Start Time and End Time of the log data.

4. You can select whether to search the DST (Daylight Saving Time) data. Select All
indicates searching all data including DST data, Y indicates searching only DST data
and N indicates not searching DST data.

5. Click Query to display the search results.

B Gender: You can view the gender of the person entered. N/A appears when the
GV-Smart Box fails to recognize the gender. You can also manually specify the
gender with the dropdown list if necessary. The modified data will be updated to
the database of the GV-Web Report.

B Age: You can view the age range of the person entered. You can also manually
specify the age group with the dropdown list if necessary. The modified data will
be updated to the database of the GV-Web Report.

® Image Snapshot: You can view the snapshot of the person entered by clicking the

l‘_J%

icon.

To back up the search results in EXCEL, WORD or PDF format, click the icons ol b4 | B

at the bottom of the Query Result List.

56



B Face Counting Page

5.4 Query Page

The Query page provides you with the daily, weekly, monthly and yearly face counting

graphs and tables. To search the face counting data, select a GV-Smart Box or GV-

DVR/NVR/VMS from the Device dropdown list or a created group from the Group dropdown

list, specify a date, and select the following options below. Use the Chart dropdown list

Chart : [Line Gragh ¥ | ahove the graphs to choose to display the data in bar graph, pie graph or

line graph.

Note: Pie graph is not available for the following types of data.

e Male Female Count per 60 Minutes

e Total Male and Female count per 60 Minutes
e Age range Count per 60 Minutes

e Total range Count per 60 Minutes.

[Daily Report] Display the face counting report of the specified date.

Male/Female count per 60 minutes: The hourly number of males and females entered
during the day.

Total male and female count per 60 minutes: The hourly accumulated number of
males and females entered during the day.

Male and female percentage: The total number and the percentage of males and
females entered during the day.

Age range count per 60 minute: The hourly number of people of each age range
entered during the day.

Total Age range count per 60 minutes: The hourly accumulated number of people of
each age group entered during the day.

Age range percentage: The total number and the percentage of people of each age
range entered during the day.
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The following figure is an example of the Male/Female count per 60 minutes option. The

value 9, 5 indicates the count of males until 9 am is 5.

@ Device: Chart ;| Line Graph 1
O roup: _ [2010-11-01] Male,female count per 60 minutes(All Device)

Daily Report({2010-11-1}

80
Male,female count per 60 minutes

Total male and female count per 60 Zd

minutes

Male and female percentage &0

Lge range count per 60 minutes o

TD_taI age range count per 60

minutes 40

Lge range Percentage
20

20

10

1] 1 2 <3 4 5 6 7 8 9 10 11 1z 13 14 15 15 18

="m= Male ="= Female ="= NIA

Time Male Fermale R Sum
0:00 1 13 43 57

1:00 1 10 5 16

z:00 =] 10 12 z8

3:00 =1 2 0 7

400 5 7 0 12

5:00 =1 9 3 18

5:00 a5 36 4 73

.00 7 9 u] 16

Figure 5-7

[Weekly Report] Display the weekly report that contains the data of 7 days before your

specified date.
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Male count percentage: The daily number and the percentage of males entered for the
week.

Female count percentage: The daily number and the percentage of females entered for
the week.

Male and female percentage: The total number and the percentage of males and
females entered for the week.

Age range percentage: The total number and the percentage of people of each age
range entered for the week.
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The following figure is an example of the Age range percentage option. The value 30 ~ 35,

321 (32.96%) indicates the number of 30 ~ 35 year-olds entered is 321. 30 ~ 35 year-olds

takes up 32.96 percent of all persons entered that week.

[Monthly Report] Display the monthly report that contains the data of a month before your

©pevice:

O Group:

Time: [2010-11-1 |5}

Chart : | Pie Graph v

Male count percentage

Female count percentage

Male and female percentage

Age range P entage

[2010-10-26~2010-11-01] Age range Percentage(All Device)

30 ~ 35, 321(32.96%)

\

®0~-5® 15~20 @ 20~25 & D~35 @ 40~45 @ 30~55 © 55~60 @ 6D~65 @ 65~70

age

Courter Percentage

0~5

z2a

13.14

15 ~ 20

70

7.19

20 ~ 25

377

3871

30 ~ 35

321

32.96

40 ~ 45

29

2.98

|2

specified date.

Figure 5-8

Male count percentage: The daily number and the percentage of males entered for the

month.

Female count percentage: The daily number and the percentage of females entered for

the month.

Male and female percentage: The total number and the percentage of males and

females entered for the month.

Age range percentage: The total number and the percentage of persons of each age

range entered for the month.
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[Yearly Report] Display the yearly report that contains the data of a year before your

specified date.

60

Male count percentage: The monthly number and the percentage of males entered for

the year.

Female count percentage: The monthly number and the percentage of females entered
for the year.
Male and female percentage: The total number and the percentage of males and

females entered for the year.

Age range percentage: The total number and the percentage of people of each age

range entered for the year.



B Face Counting Page

5.5 Custom Query Page

The Custom Query page allows you to look up the male or female counting data of different
age group during a specific time period. You can customize the X Axis and Y Axis of the line
graph.

1. Select GV-DVR/NVR/VMS or GV-Smart Box from the Device dropdown list or select a
created group from the Group dropdown list.
Set a Start Time and End Time to include the counting data during that time period.
3. To include only the data from specific time and days of the week, click Setting next to
Work Date. This window appears.

% Work dateSetting
sur) (06 3 : (05 8]~ 14 3 05 ¥]
Mon) |00 ¥ [00 ¥~ [24 ¥

Tue) [00 ][00 v|.[24 ]

=

=

=

=

i [0019]:[00 . [28 ]
ey 00 ][00 ) . [24 9]

=

=

(
(
(
(wed) [00 %] :[00 ¥~ [24 ] .
{
(
(

=

Sat) |UU V|:|UU V|~|24 v|:

Figure 5-9

Specify the days of week and time range to include and click Submit.
Select the Age groups to include or click Select All.
6. You can set the Y Axis of the line graph to the following options:

B Male Count: Shows the average number of male counted.

B Female Count: Shows the average number of female counted.
B Total Male Count: Shows the total number of male counted.

B Total Female: Shows the total number of female counted.

7.  You can set the X Axis of the line graph to display the counting data by hour, day,
month or year.

8. Click Query to see the line graph.
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In the example below, Male Count is selected for Y Axis and Per Hour is selected for X Axis.
The value 18, 124 indicates that average number of males counted from 17:00-18:00 pm is
124.

(& geobision GV-Web Report - Face Counting
Device | Group | Log | Query | Custom Query
[¥]25 ~ 30 L)
130 ~ 35
[#]35 ~ 40 00 Male Count(per hour)
V140 ~ 45
[ 45 ~ 50 can
50 ~ 55
155 ~ 60 <00
80 ~ 65
M&s ~ 70 00
70~ 75
75 ~ 20 200
80 ~ a5
¥as ~ a0 200
M50~ 05 18, 124
[#]95 ~ 100 100
- - ’ 2_1_2_3_2_;_5_?_:_9_1(.0 i1 1.23_103_14 15 16 17 18 19 2')0_21_201_2(;_24
Querl

Figure 5-10
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Chapter 6 POS Information Page

The POS Information page provides statistical data regarding the total and average sales
amount, the number of transactions, visitors, conversion and average customer value. The
POS data comes from GV-DVR/NVR/VMS.

After logging in the Web interface, click the POS Information tab on the upper right corner
of the Web page.

(2 Geovision GV-Web Report - Pos Information

@ pevice | B Group | M Log | 1 Query | B custom Query POS Information v

© :0nLine @ : Off Line
» Total List

Figure 6-1

6.1 Device Page

On the Device page, you can access the POS data of the current day.

Main page On the main page of the Device page, the POS data of the current
day is updated from the GV-Web Report server every minute. See
6.1.1 Viewing POS Information Updated Every Minute.
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6.1.1 Viewing POS Data Updated Every Minute

The data on the main page of the Device page is updated every minute from the GV-Web
Report server. The page displays the sales related statistics and graphs of all connected
GV-DVR/NVR/VMS.

(2 Geovision GV-Web Report - Pos Information

@ :0nLine @ : Off Line
> Total List
> GV-VMS @[Delete]

Sales 66,569.00

« Update Frequency : 60 sec
« Last Updated : 16:51:44
+ 56 Seconds later update

Total Device Real-ime Visitors, Transactions and Conversion of Time-Sharing chart

Time
W Visitor M Transactions M Conversion

Figure 6-2

The counts on the main page show:

Sales: The sales totals during the day.

Transactions: The number of trading completed during the day.

Avg. Sales: The average sales amount during the day.

Visitor: The number of visitors entered during the day.

Conversion(%): The proportion of visitors to transactions during the day.

Avg. Customer Value: The average transaction amount contributed by each customer
during the day.
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On the left menu, you can find these options:

m Total List: Select one GV-DVR/NVR/VMS host under the list to see the POS data. A
green mark indicates that the device is now updating data to the GV-Web Report server;
otherwise a red mark appears. On the individual device’s page, the POS data of the
current day are updated every minute from the GV-Web Report server. To remove a
device from the list, click Delete next to the device name.
® POS: Click individual device to see the POS data.

S Pa——
~User : admin Logout

(2 Geovision GV-Web Report - Pos Information
e B9 Groun (8 gp I gycr (B

@ :0nLine ®:0ff Line ]
» Total List DESKTOP-6SKULPM

> DESKTOP-65KULPM@ [Delete] Sales 66,569.00
> POS 1 Transactions 707

*»POS2 Avg. Sales 9a.16
» POS 3 Visitor 45
> POS 4 Conversion(%) 1,571.11
>POS 5 Avg. Customer Value 1,479.31

»POS 6 = Update Frequency : 60 sec

»POS 7 = Last Updated : 16:53:04

» POS 8 s 50 Seconds later update

» POS 9 Real-time Sales, Transactions and Avg. Sales of Time-Sharing chart
> POS 10 35,000
»POS 11
» P05 12
»POS 13
» POS 14
>POS 15
» POS 16
» POS 17 20,000
>POS 18
> POS 19 25,000
> POS 20
> POS 21
» POS 22
» P05 23
> POS 24
» POS 25
» POS 26
» POS 27
» POS 28
> POS 29

30,000

25,000

10,000

5,000

S B S B S s S S e S S S B S S e E e
0 3 8 9 12 15 18 21
Time

M Sales W Transactions M Avg. Sales

Figure 6-3
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6.2 Group Page
On the Group page, you can group different cameras from different GV-DVR/NVR/VMS
hosts, and then see the POS data of the set group.

To set up a group:

1. Select Add Group from the left menu of the Group page. This page appears.

] Total List Add Group
Group Grcup1| X
Manage Group DESKTOP-6SKULPM
» Add Group Mpos 1
» Maintain Group [lpos 2
» Setting Group Relations Mpos 3
[lros 4
Llross
Figure 6-4

Name the group.
Select the devices that you want to include in the group.

Click Submit.

o » @« DN

From Total List in the left menu, select the set Group to see the POS data from the
selected devices.

On the left menu of the Group page, you can find these options:

B Total List: Access the POS data of the set groups updated every minute from the GV-
Web Report server.

B Manage Group:
© Add Group: Select this option to set a group.
® Maintain Group: Select this option to modify the group setting or delete a group.

© Setting Group Relations: Drag and drop a group under another group to make it a
subgroup.
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6.3 Log Page

On the Log page, you can view the POS data of a specified time period from
GV-DVR/NVR/VMS.

a — >
~=User : admin Legout

¢ .
GeoUision GV-Web Report - Pos Information
roup 2o 1 oyery nQuery Pos Information v
P . The page show record 1-7 , total number of records : 7
( : v
® Device: et mumet of pe9ce 1
O Group: All ¥ "
. = Query Result List
start Time: [2017-55 125 [0 lo0:60 . ouenReswntust
L Device Name Pos Camera Sales Tr i Visitor Time
End Time: [2017-09-12]] [23 V]:59:59 DESKTOP-6SKULPM (M POS1 | Cameral | 16,189 166 0 2017-9-12 10:00~10:59
DESKTOP-6SKULPM (M POS 1 Cameral 33,271 333 [ 2017-9-12 11:00~11:59
DESKTOP-6SKULPM M POS 1 Cameral 33,283 354 0 2017-8-12 12:00~12:59
DESKTOP-6SKULPM (M POS 1 Cameral 33,284 353 2,985 2017-9-12 13:00~13:59
DESKTOP-6SKULPM (M POS 1 Cameral 34,084 335 0 2017-9-12 14:00~14:59
DESKTOP-6SKULPM M POS 1 Cameral 33,287 354 0 2017-8-12 15:00~15:59
DESKTOP-6SKULPM (M POS 1 Cameral 26,419 276 0 2017-9-12 16:00~16:59
= =2 B8]

Figure 6-5
To search the log data:

1. Select a specific GV-DVR/NVR/VMS from the Device dropdown list or a created group
from the Group dropdown list.

2. Specify Start Time and End Time of the log data.

3. Click Query to display the search results.

To back up the search results in EXCEL, WORD or PDF format, click the icons 2/ | B |

at the bottom of the Query Result List.
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6.4 Query Page

The Query page provides you with the daily, weekly, monthly and yearly POS data. To
search the POS data, select a GV-DVR/NVR/VMS host from the Device dropdown list or a
created group from the Group dropdown list, specify a date, and select the following options

below. Use the Chart dropdown list [Chart : (Line Graeh ¥ | ahhgye the graphs to choose to display
the data in bar graph, pie graph or line graph.

Note: Pie graph is not available for the following types of data.
o All Data under Daily Report
e Avg. Sales / Conversion / Avg. Customer per day under Weekly / Monthly / Yearly Report

[Daily Report] Display the POS data report of the specified date.
m Sales per hour: The hourly amount of sales during the day.

® Transactions per hour: The hourly accumulated number of trading completed during
the day.

m  Avg. Sales per hour: The hourly average sales amount during the day.
m Visitors per hour: The hourly number of visitors entered during the day.

m Conversion per hour: The hourly accumulated proportions of visitors to transactions
during the day.

m  Avg. Customer Value per hour: The average transaction amount contributed by each
customer per hour during the day.
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The following figure is an example of the Sales per hour option. The value 14, 19,672

indicates the amount of sales at 14 pm is 19,672.

“User : admin ~ Log

(2 Geobision GV-Web Report - Pos Information

Li Pos Information v

ey roup | B 1 og Qucry

@ Device: |DESKTOP-6SKULPM v Chart : [Line Graph
O Group: All v = [2017-08-22] Sales per hour(Device : DESKTOP-6SKULPM)
Time interval: ~[2300 v s H

Daily Report(2017-08-22) 12,000 M sales 19,672

Sales per hour

16,000

Transactions per hour

Avg. Sales per hour 14,000

Visitors per hour 12,000

Conversion per hour
Avg. Customer Value per hour 10,000

Weekly Report(2017-08-16~2017-08-22) 2,000
Monthly Report(2017-07-23~2017-08-22)

8,000

Yearly Report(2016-08-23~2017-08-22)

4,000

2,000

[ 3 & ° 2 15 R} 21
Time Sales
0:00 0
1:00 o
2:00 o
3:00 0
Figure 6-6

[Weekly Report] Display the weekly report that contains the data of 7 days before your

specified date.

Sales per day: The daily sales totals for the week.

Transactions per day: The accumulated number of trading completed daily for the week.
Avg. Sales per day: The daily average sales amount for the week.

Visitors per day: The number of visitors entered daily for the week.

Conversion per day: The accumulated proportions of visitors to transactions each day
for the week.

Avg. Customer Value per day: The average transaction amount contributed by each
customer per day for the week.
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The following figure is an example of the Visitors per day option. The value 2017-09-12
(Tue), 61.99% indicates that 3522 visitors takes up 61.99% percent of all persons entered
that week.

a S
~~User : admin Legout

Pos Information v

j gup 2g ery om n
®Device: Al v Chart : [Pie Graph v

O Group: All v [2017-09-06~2017-09-12] Visitors per day(All Device)
Time interval: ~

[Daily Report(2017-09-12)
[Weekly Report(2017-09-06~2017-09-12)
Sales per day

Transactions per day

Avg. Sales per day

Visitors per day
Conversion per day

M 2017-09-12(Tue) 61.99%
Avg. Customer Value per day

Monthly Report(2017-08-13~2017-09-12)
Yearly Report(2016-09-13~2017-09-12)

W 2017-08-12(Tue)

Time Visitor Percentage®
2017-09-06(Wed) 526 9.26
2017-09-07(Thu) 522 9.19
2017-09-08(Fri) 554 9.75
2017-09-09(Sat) 7 0.12
2017-09-10(Sun) 5 0.09
2017-09-11(Mon) 546 9.61
2017-09-12(Tue) 3,522 61,99

Sum 5,682 100

| _print NP I
Figure 6-7

[Monthly Report] Display the monthly report that contains the data of a month before your
specified date.

m Sales per day: The daily sales totals for the month.

m Transactions per day: The accumulated number of trading completed daily for the

month.
®  Avg. Sales per day: The daily average sales amount for the month.
m Visitors per day: The number of visitors entered daily for the month.

m  Conversion per day: The accumulated proportions of visitors to transactions each day
for the month.

m  Avg. Customer Value per day: The average transaction amount contributed by each
customer per day for the month.
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[Yearly Report] Display the yearly report that contains the data of a year before your

specified date.

Sales per day: The daily sales totals for the year.

Transactions per day: The accumulated number of trading completed daily for the year.
Avg. Sales per day: The daily average sales amount for the year.

Visitors per day: The number of visitors entered daily for the year.

Conversion per day: The accumulated proportions of visitors to transactions each day
for the year.

Avg. Customer Value per day: The average transaction amount contributed by each
customer per day for the year.
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6.5 Custom Query Page

The Custom Query page allows you to look up the POS data during a specific time period.
You can customize the X Axis and Y Axis of the line graph.

1. Select GV-DVR/NVR/VMS from the Device check list or select a created group from
the Group check list.

2. Click E to select a Start Time and End Time to include the POS data during that time
period.

3. To include only the data from specific time and days of the week, click Setting next to
Work Date. This window appears.

}g Work dateSetting

sun) |06 »|: |05 v . [14 »|:|05 v

Figure 6-8

Specify the days of week and time range to include and click Submit.
5.  You can set the Y Axis of the line graph to the following options:

B Sales: Shows the amount of sales.

B Transactions: Shows the number of trading completed.

B Avg. Sales: Shows the average sales amount.

B Visitor: Shows the total number of visitors.

B Conversion: Shows the total proportion of visitors to transactions.

B Avg. Customer Value: Shows the average transaction amount contributed by
each customer.

6. You can set the X Axis of the line graph to display the POS data by hour, day, month or
year.
7. Click Query to see the line graph.
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In the example below, Sales is selected for Y Axis and Per Hour is selected for X Axis. The
value 53,791 indicates the accumulative total of sales between 13:00 - 15:00 pm is 53,791
during 2017/8/9 — 2017/8/22.

(® Geovision

® Device: M Select All
V| DESKTOP-6SKULPM
O Group: ¥ Select All
Start Time: :DU:DO
End Time: :59:59

Work date: Setting

GV-Web Report - Pos Information
[ Bcoono

n POS Information Page

70.000

60.000

50,000

40,000

30,000

20,000

10.000

Sales(per hour)

1
=

F
M DESKTOP-6SKULPI

I

M 53,791

T T T
7 ] " 13

W DESKTOP-6SKULPM

T
15

Figure 6-9
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Chapter 7 Heat Map Information Page

The Heat Map Information page provides the visualized traffic data about level of motion
intensity detected in the surveillance area. This allows you to see where people are inclined
to go and stay in that area. The heat map images come from GV-VMS.

After logging in the Web interface, click the Heat Map Information tab on the upper right
corner of the Web page.

2 User : admin = Logout

(2 Geovision GV-Web Report - Heatmap Information

Heat Map Information v

Figure 7-1

Here, you can look up the visualized traffic data captured by different cameras during a
specific time period.

1. Select the GV-VMS host from the Device dropdown list.

2. Click E to select a Start Time and End Time to include the traffic data during that time
period.
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To include only the data from specific time and days of the week, click Setting next to

Full-spectral color progression: Select to see the heat map results in full color.

3.
Work Date. This window appears.
>s
Fl(sun) |06 % |.[05 | [14 « |[]5 v|
[ (Man) |00 |00 +
[#(Tue) |00 . |00 | |24 v 00
¥ (wed) |00 ¥ |:]|00 ¥ |~ |24 v
Fl(Thu) |00+ |00 v|. |24 v
[l (Fri) |00 | ;00 % |~ |24 % |, 00
[¥](5at) |[][J v| |[][] V|,.,|24 v|: 00
Figure 7-2
4. Specify the days of week and time range to include and click Submit.
5. You can set the color scheme to the following options:
[ ]
[ ]

Single hue progressions: Select to see the heat map results in single color.

In the example below, Camera 7 is selected while the Color Scheme is set as Full-spectral

color progression. The hue indicates the motion intensity from 2017-10-12 00:00:00 pm to
2017-10-12 23:59:59 pm in the surveillance area. Redder hue indicates higher motion
intensity. Bluer hue indicates less motion intensity.

Device:
Camera

Start
Time:

Color

Q GeoUision

End Time:

DESKTOP-6SKULPM v
oo}
rEER BT

59 V]

GV-Web Report - Heatmap Information

Heatmap Information v

Figure 7-3*
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Chapter 8 Object Size Counting Page

The Object Size Counting page provides counting data of vehicles that entered the
surveillance area sorted by different object sizes. The counting data can be acquired from
GV-Smart Boxes.

After logging in the Web interface, click the Object Size Counting tab on the upper right
corner of the Web page.

2 User : admin T Logout

(2 Geoision GV-Web Report - Object Size Counting

? pevice | Group | B Log | 'V Query | M custom Query Object Size Counting Vv

Figure 8-1

Note: Chapter 8 Object Size Counting Page pertains to GV-Smart Box, which is no longer
supported.

8.1 Device Page

On the Device page, you can access object size counts of the day and watch live view from
a GV-Smart Box.

Main page On the main page of the Device page, the object size counts of the
current day are updated from the GV-Web Report server every
minute. See 6.1.1 Viewing Object Size Counts Updated Every Minute.

Live View Window | On the Live View window, you can view live video from a GV-Smart
Box. See 6.1.2 Viewing Live Video.
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8.1.1 Viewing Object Size Counts Updated Every Minute

The data on the main page of the Device page is updated every minute from the GV-Web
Report server. The page displays the object size counts and graphs of all connected GV-
Smart Boxes.

(2 eovision GV-Web Report - Object Size Counting

Device | Group | Log | Query | Custom Query User: admin  Logout

@ :onLine ®:0Off Line
» Total List TEST-308-PC GV-Smart Box GV-3D People Counter
» GV-30 People Counter@[Delete] Levell |0 Level1 411 Level1 |0

. GV-Smart Box@[Dalete] [ Levelz [0 | | Level2 [208 | [ Levelz o |

» CAMERA_NAME(Live View) « Update Frequency : 60 sec

- s Last Updated : 18:36:35
> TEST-308-PCO Delete] » 51Seconds later update

Total Device Real-time object size of Time-Sharing chart

=O= Level1 =0= Level2

Figure 8-2

The table on the main page shows the number of objects counted for each size level. Three

graphs are available.

m Real-time object size: The hourly number of objects from different size levels counted
on that day is shown in a line graph.

m Real-time total object size (All Device): The accumulated number counts from different
size levels for all connected device are shown during the day in a line graph.

m Real-time total object size (Each Device): The daily accumulated object counts of
different size levels from each device are shown in a bar graph.

On the left menu, you can find these options:

m  Total List: Select one GV-Smart Box under the list to see its individual object size counts.
The green mark indicates that the device is now updating data to the GV-Web Report
server; otherwise a red mark appears. The object size counts of the current day are
updated every minute from the GV-Web Report server. To remove a device from the list,
click Delete next to the device name.
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© Camera: Access the live video if remote access is enabled on both the device and

GV-Web Report server. See 6.1.2 Viewing Live Video.

(2 6eovision GV-Web Report - Object Size Counting

Device | Group | Log | Query | Custom Query
0 : 0Online @ : Off Line
TEST-308-PC V-Smart Box

» Total List
» GV-3D People Counter@[Delete] Level 1 |0 Level 1 411
Level 2 |0 Level 2 |298

» GV-Smart Box@[Delete]
s Update Frequency : 60 sec

» CAMERA_NAME(Live View) o Undata ey o
i i e Last Updated : 18:37:
» TEST-308-PC@[Delete] * 25econds later update

I Tetol Facai Dol s e

Figure 8-3

8.1.2 Viewing Live Video

To access live video, select the desired camera from the left menu of the Device page. Make
sure remote access to GV-Smart Boxes has been enabled on the GV-Web Report. See

3.7.3 Remote Access Settings for details on how to allow remote access.

Figure 8-4
By clicking the icon on the Live View window, you can view the live video from the GV-

Smart Box.
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8.2 Group Page

On the Group page, you can group different cameras from GV-Smart Boxes, and see the

object size counts of the set group.

To set up a group:

1.

o & w DN

Select Add Group from the left menu of the Group page. This page appears.

® = - -
(2 Geouision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
> [ GroupA Group Groupl
GV-Smart Box
Manage Group Camera
, Add Group [¥] cAMERA_NAME

» Maintain Group

» Setting Group Relations
» Maintain object size name

Figure 8-5
Name the group.
Select the cameras that you want to include in the group.
Click Submit.

From Total List in the left menu, select the set Group to see the sum of every object size
count from those selected cameras.

On the left menu of the Group page, you can find these options:

Total List: Access the object size counts of the set groups updated every minute from
the GV-Web Report server.

Manage Group:
© Add Group: Select this option to set a group.
® Maintain Group: Select this option to modify the group settings or delete a group.

© Setting Group Relations: Drag and drop a group under another group to make it a
subgroup.
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B Maintain Object Size Name: Modify the display names for 6 different object sizes
defined for Traffic Counter in the GV-Smart Box.

Maintain object size name

Object size level Name
1 |Bu5| |
2 |Eii|::\_.-'c|e |
3 |Truck |
4 |M0tort:\_.-'c|e |
3 |‘u’ehic|e |
5] |Leve| ] |

Figure 8-6
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8.3 Log Page

On the Log page, you can view the counting records according to different object sizes

during a specified time period from GV-Smart Boxes.

Object Size Cuummg[v]

GeoUision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
X The page show record 1-5 , total number of records : 5
@ Device: |All [v] total number of pages : 1
O Group:
. .p Query Result Lis
Object size Al [v] Objedt si
level: Device Name Camera leve‘mze Direction| Color Start Time End Time
Direction: |All_[v] GV-Smart 2012-02-06 2012-02-06
Color: [Al ™ Box [N CAMERA_NAME 9| motorcycle Out | Red 15:12:56 15:12:56
E | GV-Smart - 2012-02-06 2012-02-06
ctart Time: fgiiloszs Ffl 15[x] oo M |CAMERA_NAME #| motorcycle | Out | Red 15:12:56 15:12:56
: = GV-Smart . 2012-02-06 2012-02-06
End Time: mizioz'FE] 15 [v]: Box (Ml |CAMERA_NAME &% motorcyde | Out | Red 15:12:56 15:12:56
12 %] 58 v
GV-Smart - 2012-02-06 2012-02-06
: L
DST: @ select all Oy ON Box (M |CAMERA_NAME & m|eiE 15:12:58 15:12:58
[ uery | GV-Smart ) ! 2012-02-06 2012-02-06
- Box (M |CAMERA_NAME & Car In | Wwhite 15:12:58 15:12:58
= = &
Figure 8-7

To search the log data:

1. Select a specific GV-Smart Box from the Device dropdown list or a created group from
the Group dropdown list.

2. Specify the Direction to see the counting results of objects moving In or Out.
3. Specify Start Time and End Time of the log data.
4. Specify the Color of the log data.

5. You can select whether to search the DST (Daylight Saving Time) data. Select All
indicates searching all data including DST data, Y indicates searching only DST data
and N indicates not searching DST data.

6. Click Query to display the search results.

B Object Size Level: You can view the size level of the object detected. You can
define up to 6 object size levels in the GV-Smart Box and label the different object
size levels under the Group Page. See Figure 6-6.

B Direction: You can see whether the object is moving toward the In or Out direction
defined in the GV-Smart Box.

To back up the search results in EXCEL, WORD or PDF format, click the icons By = |

at the bottom of the Query Result List.
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8.4 Query Page

The Query page provides you with the daily, weekly, monthly and yearly object size counting
graphs and tables. To search the object size counting data, select a GV-Smart Box from the
Device dropdown list or a created group from the Group dropdown list, specify a date, and

select the following options below. Use the Chart dropdown list [Chart : (Line Gragh ¥ | above the
graphs to choose to display the data in bar graph, pie graph or line graph.

Note: Pie graph is not available for the following types of data.
o  Object size count per 60 minutes
o Total object size count per 60 minutes

[Daily Report] Display the object size counting report of the specified date.

m  Object size count per 60 minutes: The number of objects from each object size level

counted per hour.

m Total object size count per 60 minutes: The accumulated number of objects from each

object size level counted per hour.

m  Object size percentage: The total number and the percentage of objects from each
object size level counted on that day.

The following figure is an example of the Object size count per 60 minutes option. The
value 20, 6478 indicates the number of cars counted from 19:00-20:00 pm is 6478.

Object Size Cnumlng[vl

(2 Geovision GV-Web Report - Object Size Counting

Device | Group | Log | Query | Custom Query User: admin  Logout

®pevice: Al [] Chart : |Line Graph [+]
OGmup:

[2012-02-06] Object size count per 60 minutes(All Device)

Date: 8,000
Time interval: |0:00 [V] ~ 23:00[V]
[Object size count per 60 minutes | £.000
Total object size count per 60 minutes
Object size percentage 5.000
(2012-1-31~2012-2-6)

2,000

1,000

[

15 18 15 20 21
=Cm= Motorcycle == Car

Time Motarcycle Car Sum
15:00 1,051 1,063 2,114

18:00 4,248 3,739 7,987

19:00 7,418 6,526 13,044
20:00 7,463 6,478 13,941
21:00 1,172 982 2,154

Sum 21,352 18,788 40140

Figure 8-8
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[Weekly Report] Display the weekly report that contains data of the 7 days before your
specified date.

m  Object size percentage: The daily number and the percentage of objects from each

object size level counted for the week.

Below is an example of the weekly Object size percentage. The value Motorcycle, 1,176
(2.84%) indicates that the number of objects from the Motorcycle size level counted is 1,176
for that week. Motorcycles takes up 2.84 percent of all traffic counted that week.

= ) ) ]
(2 6eovision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
-~
@ Device: Al Chart : |Pie Graph |+ T
O Group: A
__ [2012-02-10] Object size percentage(All Device)

Time

) Motorcycle, 1,176(2.84%) |
interval: !

(2012-2-4~2012-2-10)

Object size percentage

PeoplePercentage

BicyclePercentage

TruckPercentage

MotorcyclePercentage

VehiclePercentage

Level 6Percentage
(2012-1-11~2012-2-10)

(2011-2-11~2012-2-10)

@ People Bicycle @ Motorcycle ‘Vehicle
Object size level Counter Percentage%
People 5,058 12.21
Bicycle 28,577 69
Motorcycle 1,176 2.84
Vehicle 6,606 15.95
Sum 41,417 100
Figure 8-9
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[Monthly Report] Display the monthly report that contains the data of a month before your
specified date.

m  Object size percentage: The total number and the percentage of objects from each
object size level counted for the month.

Below is an example of the monthly Car percentage. Object size level 2 defined in GV-
Smart Box was renamed to Car in the Group page. The value 12-02-06(Mon), 18,788
(96.95%) indicates that the number of objects from the Car size level counted is 18,788 on
2012/02/06 and it takes up 96.95 percent of all traffic counted that month.

L ] 2ot . a .
(2 Geovision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
@ Device: | Al v Chart
O Group:

[2012-02-05~2012-02-11] Car Percentage(All Device)

Date: [2012-2-11 |2
Time [ .
interval: 000 v [23:00 v

2012-02-06(Mon), 18,788(96.95%)

Ohject size percentage
Motorcycle Percentage
Car Percentage
BicyclePercentage
TruckPercentage
Level SPercentage

® 2012-02-06(Mon) @ 2012-02-08(Wed) @ 2012-02-05(Thu)

Time Car Percentage
2012-02-06(Man) 18,788 956.95
2012-02-08(Wed) 569 2.94
2012-02-09(Thu) 22 0.11

Sum 19,379 100

Figure 8-10

[Yearly Report] Display the yearly report that contains the data of a year before your
specified date.

m Object size percentage: The monthly number and the percentage of objects from each
object size level counted.
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8.5 Custom Query Page

The Custom Query page allows you to look up the object counting data of different size
levels during a specific time period. You can customize the X Axis and Y Axis of the line
graph.

1. Select a GV-Smart Box from the Device check list or select a created group from the
Group check list.
Set a Start Time and End Time to include the counting data during that time period.
3. To include only the data from specific time and days of the week, click Setting next to
Work Date. This window appears.

N o dmtesetting

[ (sun) |06 ¥ |05 v|. |14 v/|.[05 v|
[ (Mon) |00 | :|00 ¥ | |24 v/

[ (Tue) [00 v |: 00 v| . [24 v

[ (wed) |00 ] : [00 v] . [24 ] .

& (thu) [00 ] : [00 [v] . [24 (+] .
FI(Fri) |00 v|:[00 v . 24 ¥ .

[ (sat) |00 ¥|: |00 ¥ |24 ¥/,

Figure 8-11

Specify the days of week and time range to include and click Submit.
5.  You can set the Y Axis of the line graph to the following options:

B Level 1-6: Shows the number of objects from that size level counted. If you have
customized the name of the size level in the Group page, the modified name will
be displayed here.

6. You can set the X Axis to the line graph to display the counting data by hour, day,
month or year.

7.  Click Query to see the line graph.
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In the example below, the average hourly motorcycle count from 2/2 to 2/8 is shown in a line
graph. The value 18, 4248 indicates that between 2/2 and 2/8, the average number of
motorcycles counted from 17:00-18:00 pm is 4248.

Object Size Counting M

(2 6eovision GV-Web Report - Object Size Counting

User: admin  Logout

M Gv-Smart Box
] GV-Smart Box

o} Select Al
Group: GroupA

Time: UUM: UUM
Y v el
Time: 59+ |{59[v|

Work .
date: Setting

Y Axis: Motorcycle&]
¥ Axis: | per hour [i]

Device | Group | Log | Query | Custom Query
® M select Al
Device: ¥l Gv-smart Box

8,000

7,000

&,000

5,000

4,000

2,000

2,000

1,000

4

Motorcycle (per hour)

18, 4,248

5 & 7 8 9 10 11 12 12 14 15 16 17 18 15 20 21 22 23 24

== GV-SmartBox == GV-Smart Box =C= GV-Smart Box
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Chapter 9 Mobile Phone Connection

Using an iPhone, iPad, or any Android-based mobile device, users can access people
counting and face counting results directly on their mobile phones. After logging in via the
mobile browser, you can query historical data and view charts and reports.

This enables convenient, on-the-go monitoring from anywhere with internet access.

1. On your mobile device, type the IP address of the GV-Web Report server in the address
field of the browser. The login dialog box appears.

4 0 M 4+ [192168019

O Remember my Account and Password

Figure 9-1

2. Type the account ID and password.

3. Click Login. The People Counting results for that day appear.
T =

untitiod

| © [ 4 | 192.168.0.198/App/Counter_Live_mobile.... G |
Data ‘ Chart [Peuple Counting n
People Counting [ 2010-11-01 ] Logout
Device : | Al v
GV-Smart Box
In 721
Out 456

Average In |1
Average Out |0

Total In: 721 | Total Out: 456 | Stay: 265

* Total In(Out): on behalf of today 0:00
until now In(Out)

* Average In(Out): on behalf of today
0:00 until now average In(Out) per
minute

Figure 9-2
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4. To see the data of other devices, tap the Device dropdown list.

5. To see graphs of the results, tap the Chart tab on the top. This window appears.

Untitied

<4 © 3 4+ | 192169.0.199/App/Counter_Live_mabile.... < |
Data | Chart People Counting [

Date : [ 2010-11-01 | Logout

Device : [ Al v
2010-11-01

InfOut Counts per hour and Total Stay
300

250
200
150
100

50 & 40

Figure 9-3

6. Tap the Date dropdown list to select a date and tap the Device dropdown list to select a
device.

7. Use the Type dropdown list to display the results of that day, week, month or year.

8. To switch to Face Counting results, tap the People Counting button on the top-right
corner and select Face Counting. The Face Counting results for that day appear.

uuuuuu

4 © 0+ 1921680, 189AppCounter Live F_mabi.
Data ‘ Chart Face Counting

Face Counting [ 2010-11-01 ] Logout
Device : | All v

GV-Smart Box

Face counts [974
Male 391
Female 455
n/a 128

Total Male Count: 391 | Total Female
Count: 455

» Total Male(Female): on behalf of today
0:00 until now male(female) count

Figure 9-4

9. To see the data of other devices, tap the Device dropdown list.
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10. To see graphs of the results, tap the Chart tab on the top. This window appears.

uuuuuu

« IO M 4 o 22182.01994pp Counts:_Live_=_mebi

Data | Chart
Date : | 2010-11-01 | Logout

Device : | All v
2010-11-01

Male, female count per 60 minutes
100 ~

|

G0

60

Figure 9-5

11. Tap the Date dropdown list to select a date and tap the Device dropdown list to select a

device.

12. Use the Type dropdown list to display the results of that day, week, month or year.
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Appendix

Modifying Port Number for running GV-Web Report on the same

computer with GV-DVR/NVR/VMS

Since the GV-Web Report server and the WebCam Server of GV-DVR/NVR/VMS share
the same HTTP port number of 80 to connect to the Web, it is required to modify the port
number of either GV-Web Report or WebCam Server if both of them are running on the
same computer. If not, the following message will appear and you cannot access the Web
interface of the GV-Web Report server:

Starting Web Server Failed

To modify the HTTP port number of GV-Web Report:
1. Click Tools from the menu bar and select General Setting.

2. Inthe Web Server section, change the default Listen Port of 80 to a different port number
within the range of 1024 to 65535.

3. Click Apply.
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